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ii WT41N0 Integrator Guide
No part of this publication may be reproduced or used in any form, or by any electrical or mechanical means, 
without permission in writing from Zebra. This includes electronic or mechanical means, such as photocopying, 
recording, or information storage and retrieval systems. The material in this manual is subject to change 
without notice.

The software is provided strictly on an “as is” basis. All software, including firmware, furnished to the user is on 
a licensed basis. Zebra grants to the user a non-transferable and non-exclusive license to use each software 
or firmware program delivered hereunder (licensed program). Except as noted below, such license may not be 
assigned, sublicensed, or otherwise transferred by the user without prior written consent of Zebra. No right to 
copy a licensed program in whole or in part is granted, except as permitted under copyright law. The user shall 
not modify, merge, or incorporate any form or portion of a licensed program with other program material, create 
a derivative work from a licensed program, or use a licensed program in a network without written permission 
from Zebra. The user agrees to maintain Zebra’s copyright notice on the licensed programs delivered 
hereunder, and to include the same on any authorized copies it makes, in whole or in part. The user agrees not 
to decompile, disassemble, decode, or reverse engineer any licensed program delivered to the user or any 
portion thereof.

Zebra reserves the right to make changes to any software or product to improve reliability, function, or design.

Zebra does not assume any product liability arising out of, or in connection with, the application or use of any 
product, circuit, or application described herein.

No license is granted, either expressly or by implication, estoppel, or otherwise under any Zebra Technologies 
Corporation, intellectual property rights. An implied license only exists for equipment, circuits, and subsystems 
contained in Zebra products.
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Revision History
Changes to the original manual are listed below:

Change Date Description

-01 Rev. A 12/01/2012 Initial release.

-02 Rev. A 12/11/2014 Zebra rebranding

-02 Rev. B 03/2015 Zebra rebranding

-02 Rev. C 05/2016 Remove references to Device Configuration Package, which is not supported in CE 7.0.

-03 Rev. A 11/2016 Add support for RS5000.

-04 Rev. A 12/2016 Provide special instructions for RS5000.
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ABOUT THIS GUIDE
Introduction
This guide provides information about using the WT41N0 family of mobile terminals and accessories. The WT41N0 
has three versions:

• Touch display

• Non-touch display

• Voice-only version without a display.

Throughout this guide Voice Only WT41N0 refers to the version without the display and WT41N0 refers to the 
version with a display. Wearable terminal refers to all versions.

Documentation Set

The documentation set for the WT41N0 is divided into guides that provide information for specific user needs.

• WT41N0 Quick Start Guide - provides information for using the WT41N0 wearable terminal.

• Voice Only WT41N0 Quick Start Guide - provides information for using the Voice Only WT41N0 wearable 
terminal.

• WT41N0 User Guide - describes how to operate the wearable terminal.

• WT41N0 Integrator Guide - describes how to set up the wearable terminal and the accessories.

• EMDK Help File - provides API information for writing applications.

NOTE Screens and windows pictured in this guide are samples and can differ from actual screens.
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Configurations
This guide covers the following configurations:

Software Versions

This guide covers various software configurations and references are made to operating system or software 
versions for:

• OEM version

• Fusion version.

OEM Software

To determine the OEM software version:

1. Press CTRL and then ESC to open the Start menu.

2. Using the navigation keys, select Settings.

3. Press the Blue key and the down arrow to open the Control Panel sub-menu.

4. Press ENTER key to launch Control Panel.

5. Using the navigation keys, select the System Information icon.

6. Press ENTER key to launch System Information applet.

Configuration Radios Display Memory Data 
Capture

Operating
System Keypads

WT41N0 WLAN: 
802.11a/b/g/n
WPAN: Bluetooth

2.8” QVGA 
Color; 
non-touch

2 GB Flash/
512 MB RAM

Optional 
accessory

Windows 
CE 7.0 
Professional

Alphanumeric 
Keypad

2.8” QVGA 
Color; 
touch

2 GB Flash/
512 MB RAM

Optional 
accessory

Windows 
CE 7.0 
Professional

Alphanumeric 
Keypad

Voice Only 
WT41N0

WLAN: 
802.11a/b/g/n
WPAN: Bluetooth

None 2 GB Flash/
512 MB RAM

Optional 
accessory

Windows 
CE 7.0 
Professional

Three keys

NOTE To view the software versions on the Voice Only WT41N0, the Voice Only WT41N0 must be 
connected to a host computer running remote desktop software.  See Chapter 4, Voice Only 
WT41N0 Remote Control for more information.

ZEBRA WT41N0
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Fusion Software

To determine the Fusion software version:

1. Press ALT - w. The Wireless menu appears.

2. Using the navigation keys, select Wireless Status.

3. Press ENTER. The Wireless Status window displays.

4. Press 6. The Versions screen appears.

Chapter Descriptions
Topics covered in this guide are as follows:

• Chapter 1, Getting Started, lists the accessories for the wearable terminal and explains how to install and 
charge the batteries and start the wearable terminal for the first time.

• Chapter 2, Accessories, describes the accessories available for the wearable terminal.

• Chapter 3, Synchronization, provides instructions on installing ActiveSync and setting up a partnership 
between the wearable terminal and a host computer.

• Chapter 4, Voice Only WT41N0 Remote Control, provides instructions for using remote control software 
with the Voice Only WT41N0.

• Chapter 5, Wireless Applications, provides instructions on using and configuring the wearable terminal 
on a wireless network.

• Chapter 6, Bluetooth, explains Bluetooth functionality on the wearable terminal.

• Chapter 7, Application Development, describes features in Windows CE 7.0 including how to package 
applications, and procedures for deploying applications onto the wearable terminal.

• Chapter 8, Special Considerations, provides special instructions for the wearable terminal.

• Chapter 9, Maintenance & Troubleshooting, includes instructions on cleaning and storing the wearable 
terminal, and provides troubleshooting solutions for potential problems during wearable terminal 
operation.

• Appendix A, Technical Specifications, includes a table listing the technical specifications for the wearable 
terminal and accessories.

Notational Conventions
The following conventions are used in this document:

• “Wearable terminal” refers to the WT41N0 series of wearable terminals.

2015 Symbol Technologies, Inc.
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• Italics are used to highlight the following:

• Chapters and sections in this guide

• Related documents

• Bold text is used to highlight the following:

• Dialog box, window and screen names

• Drop-down list and list box names

• Check box and radio button names

• Icons on a screen

• Key names on a keypad

• Button names on a screen.

• Bullets (•) indicate:

• Action items

• Lists of alternatives

• Lists of required steps that are not necessarily sequential.

• Sequential lists (e.g., those that describe step-by-step procedures) appear as numbered lists.

• Key sequences. When multiple key presses are required, follow the following 

• Key - key: Press and release the first key and then press and release the second key.

Related Documents and Software
The following documents provide more information about the WT41N0 wearable terminals.

• WT41N0 Quick Start Guide, p/n 72-157178-xx

• Voice Only WT41N0 Quick Start Guide, p/n 72-162043-xx

• WT41N0 Regulatory Guide, p/n 72-159559-xx

• WT41N0 User Guide, p/n 72E-159561-xx

• RS309 Scanner Quick Reference Guide, p/n 72-86011-xx

• RS409 Scanner Quick Reference Guide, p/n 72-86010-xx

• RS419 Scanner Quick Reference Guide, p/n 72-158357-xx

• RS507 Hands-free Imager Quick Reference Guide, p/n 72-115987-xx

• RS507 Hands-free Imager Product Reference Guide, p/n 72E-120802-xx

• RS5000 Scanner Quick Reference Guide, p/n MN-002933-xx

• Wireless Fusion Enterprise Mobility Suite User Guide for Version 2.XX, p/n 72E-xxxxxx-xx

• Enterprise Mobility Developer Kits, available at: http://www.zebra.com/support.

• Platform SDK (PSDK41N0c70) for WT41N0 with Windows CE 7.0, available at: 
http://www.zebra.com/support.

• ActiveSync software, available at: http://www.microsoft.com.

For the latest version of this guide and all guides, go to: http://www.zebra.com/support.

http://www.zebra.com/support
http://www.zebra.com/support
http://www.microsoft.com
http://www.zebra.com/support
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Service Information
If you have a problem with your equipment, contact Zebra Global Customer Support for your region. Contact 
information is available at: http://www.zebra.com/support.

When contacting Zebra Global Customer Support, please have the following information available:

• Serial number of the unit

• Model number or product name

• Software type and version number

Zebra responds to calls by email, telephone or fax within the time limits set forth in support agreements.

If your problem cannot be solved by Zebra Global Customer Support, you may need to return the equipment 
for servicing and will be given specific directions. Zebra is not responsible for any damages incurred during 
shipment if the approved shipping container is not used. Shipping the units improperly can possibly void the 
warranty.

If you purchased your Zebra business product from a Zebra business partner, contact that business partner for 
support.
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CHAPTER 1 GETTING STARTED
Introduction
This chapter lists the accessories for the wearable terminal and explains how to install and charge the batteries 
and start the wearable terminal for the first time.

Unpacking the Wearable Terminal
Carefully remove all protective material from around the wearable terminal and save the shipping container for 
later storage and shipping.

Verify that you received all equipment listed below:

• Wearable terminal

• Lithium-ion battery

• Regulatory Guide

• Quick Start Guide.

Inspect the equipment for damage. If you are missing any equipment or if you find any damaged equipment, 
contact Zebra Global Customer Support immediately. See Service Information on page xv for contact 
information.

Features
Figure Figure 1-1 and Figure 1-2 indicate the features of the WT41N0 and Voice Only WT41N0 wearable 
terminals.
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Figure 1-1    WT41N0 Wearable Terminal Front View

Figure 1-2    Voice Only WT41N0 Wearable Terminal Front View

Application
Keypad

Display

Programmable LED 2

Data Entry Keypad

Power Button

Action Keypad Speaker

Microphone

Charge Status LED

Programmable LED 1

Charge Status LED

WLAN Status LED

Power Button

Action Keypad Speaker

Application 
Controlled LED Battery Status LED
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Figure 1-3    Wearable Terminal Back View

Getting Started
In order to start using the wearable terminal for the first time:

• Install the main battery

• Charge the main battery and backup battery

• Start the wearable terminal.

Installing and Removing the Main Battery

Installing the Main Battery

Before using the wearable terminal, install a lithium-ion battery by placing the battery into the wearable terminal 
as shown in Figure 1-4.

When a battery is fully inserted in a wearable terminal for the first time, upon the wearable terminal’s first power 
up, the device boots and powers on automatically.

Battery

Interface Connector
Rubber Plug

Interface Connector
(shown without Rubber Plug)

Cradle Connector

Cleat

Battery Release

NOTE The main battery can be charged before or after installation into the wearable terminal. Use the Single 
Slot USB cradle or Four Slot Spare Battery Charger to charge the main battery before installation, or the 
Single Slot USB cradle or Four Slot Ethernet cradle to charge the main battery after installation.

NOTE Ensure the battery is fully inserted. An audible click can be heard as the battery is fully inserted. A 
partially inserted battery may result in unintentional data loss.



1 - 4 WT41N0 Integrator Guide
Figure 1-4    Installing the Main Battery

Charging the Battery

Charging the Main Battery and Backup Battery

Before using the wearable terminal for the first time, charge the main battery until the amber Charge Status 
LED remains lit (see Table 1-1 on page 1-5 for charge status indications).

The wearable terminal is equipped with a backup battery which automatically charges from the main battery 
whether or not the wearable terminal is operating or is in suspend mode. The backup battery retains data in 
memory for at least 15 minutes when the wearable terminal's main battery is removed or fully discharged. 
When the wearable terminal is used for the first time or after the backup battery has fully discharged, the 
backup battery requires approximately 15 hours to fully charge. Do not remove the main battery from the 
wearable terminal for 16 hours to ensure that the backup battery fully charges. If the main battery is removed 
from the wearable terminal or the main battery is fully discharged, the memory backup battery completely 
discharges in several hours.

When the wearable terminal reaches a very low battery state, the combination of main battery and backup 
battery retains data in memory for at least 24 hours.

Charge the wearable terminal with an installed main battery using either the Single Slot USB cradle or the Four 
Slot Ethernet cradle.

To charge the main battery:

1. Ensure the cradle used to charge the main battery is connected to the appropriate power source.

2. Insert the wearable terminal into a cradle.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 
9-3.

NOTE Do not remove the main battery within the first 15 hours of use. If the main battery is removed before the 
backup battery is fully charged, data may be lost.
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3. The wearable terminal starts to charge automatically. The amber Charge Status LED lights to indicate the 
charge status. See Table 1-1 for charging indications.

Charging Spare Batteries

Use the following accessories to charge spare batteries:

• Single Slot USB cradle

• Four Slot Spare Battery charger.

To charge a spare battery:

1. Ensure the accessory used to charge the spare battery is connected to the appropriate power source.

2. Insert the spare battery into the accessory’s spare battery charging slot with the charging contacts facing 
down (over the charging pins) and gently press down on the battery to ensure proper contact.

3. The battery starts to charge automatically. The amber charge LED on the accessory lights to show the 
charge status. See Chapter 2, Accessories for accessory charge LED indicator definitions.

Removing the Main Battery

To remove the main battery:

1. Prior to removing the battery, ensure that the wearable terminal is in suspend mode. If the wearable 
terminal is not in suspend mode, press the Power button to place the wearable terminal in suspend mode.

2. Press the battery release button. The battery partially ejects from the wearable terminal.

3. Remove the battery from the wearable terminal.

Table 1-1    Wearable Terminal LED Charge Indicators

LED Indication

Off Wearable terminal is not in cradle. Wearable terminal not placed correctly. Charger is 
not powered.

Fast Blinking Amber Charging error:

• Temperature is too low or too high.
• Charging has gone on too long without completing (typically eight hours).

Slow Blinking Amber Wearable terminal is charging.

Solid Amber Charging complete.

Note: When the battery is initially inserted in the wearable terminal, the amber LED 
flashes once if the battery power is low or the battery is not fully inserted.
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Figure 1-5    Removing the Main Battery

Starting the Wearable Terminal
Press the Power button to turn on the wearable terminal. If the wearable terminal does not power on, perform 
a cold boot. See Performing a Cold Boot on page 1-8.

WT41N0 Boot Up

When the WT41N0 is powered on for the first time the splash screen appears for a short period of time 
followed by the Start Up window on non-touch configurations and the calibration screen on touch enabled 
configurations.

Figure 1-6    Start Up Window App Launcher

Voice Only WT41N0 Boot Up

When the Voice Only WT41N0 is powered on the three LEDs on the front housing light in the sequence shown 
in Table 1-2.

Battery Release

NOTE When a battery is fully inserted in a wearable terminal for the first time, upon the wearable terminal’s first 
power up, the device boots and powers on automatically.
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Figure 1-7    Voice Only WT41N0 LEDs

The WLAN Status LED blinks indicating that the wireless connection is not connected or is solid indicating that 
the wireless connection is connected.

Checking Battery Status

To check whether the main battery or backup battery in the wearable terminal is charged:

1. Select Start > Settings > Control Panel > Power icon to display the Battery Status window.

2. Press ENTER.

To save battery power, set the wearable terminal to turn off after a specified number of minutes.

Table 1-2    Voice Only WT41N0 Start Up LED Sequence

Sequence Application Controlled LED Battery Charge LED WLAN Status LED

1 On On On

2 On On Off

3 Off Off Off

4 On Off Off

5 On On Off

6 On On On

7 On On Off

8 On Off Off

9 Off Off Off

10 Off Off On/Blinking

Application Controlled LED Battery Charge LED WLAN Status LED

NOTE To navigate using the keypad refer to the WT41N0 Wearable Terminal User Guide.
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Configuring the Wearable Terminal
• To set up ActiveSync to synchronize the wearable terminal with the host computer, see Chapter 3, 

Synchronization.

• To configure the wearable terminal for wireless LAN network, see Chapter 5, Wireless Applications.

• To deploy software on the wearable terminal, see Chapter 7, Application Development.

Resetting the Wearable Terminal
There are two reset functions, warm boot and cold boot. A warm boot restarts the wearable terminal by closing 
all running programs.

A cold boot also restarts the wearable terminal, but erases all stored records and entries in RAM. Data saved in 
flash memory is not lost. In addition it returns formats, preferences and other settings to the factory default 
settings.

Perform a warm boot first. This restarts the wearable terminal and saves all stored records and entries. If the 
wearable terminal still does not respond, perform a cold boot.

Performing a Warm Boot

Hold down the Power button for approximately five seconds. As soon as the wearable terminal starts to 
perform a warm boot release the Power button.

Performing a Cold Boot

A cold boot restarts the wearable terminal and erases all user stored records and entries that are not saved in 
flash memory (Application and Platform folders). Never perform a cold boot unless a warm boot does not solve 
the problem.

To perform a cold boot on a WT41N0 press and simultaneously hold the Power button and the 1 and 9 keys. 
Do not hold down any other keys or buttons. The wearable terminal initializes.

To perform a cold boot on a Voice Only WT41N0 press and simultaneously hold the P1 and P2 keys, and the 
Power button. The Voice Only WT41N0 initializes.

Battery Management

Battery Saving Tips

• Place the wearable terminal in a cradle connected to AC power at all times when not in use.

• Set the wearable terminal to turn off after a short period of non-use.

• Set the display and keypad backlight to turn off after a short period of non-use.

• Turn on the keypad backlight only if needed.

NOTE Any data previously synchronized with a computer can be restored during the next ActiveSync operation.
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• Turn off all wireless radio activity when not in use.

Changing the Power Settings

To set the wearable terminal to turn off after a short period of non-use:

1. Select Start > Settings > Control Panel > Power icon > Advanced tab.

2. Press ENTER.

3. Select the On battery power: Turn off device if not used for: check box and select a value from the 
drop-down list box.

4. Press ENTER.

Changing the Display Backlight Settings

To change the display backlight settings in order to conserve more battery power:

1. Select Start > Settings > Control Panel > Backlight icon > Battery Power tab.

2. Press ENTER.

3. Select the On battery power: Disable backlight if not used for: check box and select a value from the 
drop-down list box.

4. Select the Brightness tab.

5. Select the Disable backlight check box to completely turn off the display backlight.

6. Use the slider to set the brightness of the backlight. Set it to a low value to save battery power.

7. Press ENTER.

Changing the Keypad Backlight Settings

To change the keypad backlight settings in order to conserve more battery power:

1. Select Start > Settings > Control Panel > Keylight icon > Battery Power tab.

2. Press ENTER.

NOTE To navigate using the keypad refer to the WT41N0 User Guide.

NOTE To navigate using the keypad refer to the WT41N0 User Guide.
Not applicable on the Voice Only WT41N0.

Changing the Backlight setting on the Voice Only WT41N0 will change the brightness of the Application 
Controlled LED. Refer to the EMDK Help file WT41N0-VOW Programming page for more information.

NOTE To navigate using the keypad refer to the WT41N0 User Guide.
Not applicable on the Voice Only WT41N0.

Changing the Keypad Backlight setting on the Voice Only WT41N0 will change the brightness of the 
WLAN Status LED. Refer to the EMDK Help file WT41N0-VOW Programming page for more information.
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3. Select the On battery power: Disable keylight if not used for: check box and select a value from the 
drop-down list box.

4. Select the Advanced tab.

5. Select the Disable keylight check box to completely turn off the keypad backlight.

6. Press ENTER.

Turning the WLAN Radios Off

To turn off the WLAN radio:

1. Press ALT - w. The Wireless menu appears.

2. Select Disable Radio.

3. Press ENTER.

To turn on the radio:

1. Press ALT - w. The Wireless menu appears.

2. Select Enable Radio.

3. Press ENTER.

Long Term Storage
When storing the wearable terminal for a long period of time it is recommended to place the wearable terminal 
in storage mode.

1. Remove the main battery.

2. On the WT41N0, press and simultaneously hold the 1, 9 keys and Power button (cold boot).

or

On the Voice Only WT41N0, press and simultaneously hold the P1 and P2 keys and the Power button 
(cold boot).

3. Release the keys and Power button.

When returning the wearable terminal to everyday operation, install a fully charged main battery.

NOTE To navigate using the keypad refer to the WT41N0 User Guide.



CHAPTER 2 ACCESSORIES
Introduction
Wearable terminal accessories provide a wide variety of product support capabilities. Accessories include 
cradles, a battery charger, scanners and headsets. Table 2-1 lists the accessories available for the WT41N0.

Table 2-1    Wearable Terminal Accessories

Accessory Description

Single Slot USB Cradle Charges the wearable terminal main battery and a spare battery. It also 
synchronizes the wearable terminal with a host computer through a USB 
connection.

Four Slot Ethernet Cradle Charges up to four wearable terminals (with main battery installed) and provides 
communication through an Ethernet connection.

Four Slot Spare Battery 
Charger

Charges up to four spare batteries.

RS409 Scanner Provides 1D scanning capability.

RS419 Scanner Provides 1D scanning capability.

RS309 Scanner Provides 1D scanning capability.

RS507 Scanner Provides wired or wireless imaging capability.

RS5000 Scanner Provides wired imaging capability.

Wrist Mount Provides a means for wearing the wearable terminal on the arm for hands-free 
applications.

Hip Mount Provides a means for wearing the wearable terminal on a belt for hands-free 
applications.

Headset For audio playback/recording during voice-enabled applications.

Headset Adapters Connect an optional headset to the wearable terminal.
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Replacement Batteries Standard Capacity Battery: 2330 mAh (minimum)

Extended Capacity Battery: 4600 mAh (minimum)

Standard Capacity Battery

Freezer Pouch

Allows the user to use the wearable terminal with standard capacity battery in a 
freezer environment on the hip or wrist for use in voice picking applications.

Extended Capacity Battery 
Freezer Pouch

Allows the user to use the wearable terminal with extended capacity battery in a 
freezer environment on the hip or wrist for use in voice picking applications.

USB Adapter Connects the Single-slot cradle to USB hubs, mice, keyboards and memory. The 
adapter has a USB mini-A connector on the cradle side and a USB A Female 
connector on the other side.

Connector Shroud Protects the connector of an accessory that connects to the wearable computer.

Screen Protectors Package of 3 screen protectors.

Arm Sleeve Extra layer sleeve to wear under wrist mount for extra comfort and hygiene.

RCH51 Rugged Cabled 
Headset

Enables hands-free voice-directed mobility communication. An audible mono 
headset with noise cancelling boom microphone helps survive harsh 
environments.

Table 2-1    Wearable Terminal Accessories (Continued)

Accessory Description
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Single Slot USB Cradle

This section describes how to set up and use a Single Slot USB cradle with the wearable terminal. For USB 
communication setup procedures see Communication Setup on page 2-5.

The Single Slot USB cradle:

• Provides 5.4 VDC power for operating the wearable terminal.

• Provides USB ports for data communication between the wearable terminal and a host computer or other 
serial devices (e.g., a printer).

• Synchronizes information between the wearable terminal and a host computer. (With customized or third 
party software, it can also be used to synchronize the wearable terminal with corporate databases.)

• Charges the wearable terminal’s battery.

• Charges a spare battery.

• Provides a location for storing an attached scanner during charging.

Figure 2-1    Single Slot USB Cradle Setup

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 
9-3.

NOTE The normal function of the product may be disturbed by Strong Electro Magnetic Interference (for example, 
static electricity). If so, simply remove and re-insert the terminal to resume normal operation. In case the 
function does not resume, please use the product in another location.

USB Port

USB Port

DC Cable

Power Supply

Power Port

USB Cable

AC Line CordUSB A Male

Mini USB B
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Figure 2-2    Wearable Terminal and Spare Battery Charging

Battery Charging Indicators

The Single Slot USB cradle can charge the wearable terminal’s main battery and a spare battery 
simultaneously. The wearable terminal’s amber Charge Status LED indicates the status of the battery charging 
in the wearable terminal. See Table 1-1 on page 1-5 for charging status indications. The amber Spare Battery 
Charge Status LED on the cradle (see Figure 2-1 on page 2-3) indicates the status of the spare battery 
charging in the cradle. See Table 2-2 for charging status indications. The standard capacity batteries usually 
charge in less than four hours and the extended capacity battery usually charges in less than eight hours.

1

2

Spare Battery 
Charge Status LED

Table 2-2     Spare Battery Charge Status LED Indicator

Spare Battery LED
(on cradle) Indication

Off No spare battery in well; spare battery not placed correctly; cradle is not powered.

Fast Blinking Amber Charging error:

• Temperature is too low or too high.
• Charging has gone on too long without completing (typically eight hours).

Slow Blinking Amber Spare battery is charging.

Solid Amber Charging complete.
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Communication Setup

The wearable terminal can communicate with a host computer using the Single Slot USB cradle. By default the 
wearable terminal is configured to communicate using USB. Ensure that ActiveSync on the host computer is 
set to allow USB connections.

1. Ensure that ActiveSync was installed on the host computer and a partnership was created.

2. Start ActiveSync if it is not running on the host computer. To start, select Start > Programs > Microsoft 
ActiveSync.

Figure 2-3    ActiveSync - Not Connected

3. In the ActiveSync window, select File > Connection Settings. The Connection Settings window 
displays.

Figure 2-4    Connection Settings

4. Select Allow USB connection check box.

5. Select OK to save any changes made.

6. Connect the device to the host computer.

NOTE Every wearable terminal should have a unique device name. Never try to synchronize more than one 
wearable terminal to the same name. The device name is set in the System Properties window.

NOTE The cradle requires a dedicated port. It cannot share a port with an internal modem or other device. Refer 
to the computer user manual supplied to locate the serial port(s).
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7. Upon connection, synchronization occurs automatically.

Four Slot Ethernet Cradle

This section describes how to set up and use a Four Slot Ethernet cradle with the wearable terminal.

The Four Slot Ethernet cradle:

• Provides 5.4 VDC power for operating up to four wearable terminals.

• Enables data communication between the wearable terminal (up to four) and a host computer, over an 
Ethernet network (using a standard 10Base-T Ethernet cable). The CRD4000-4000ER provides a 
maximum of 100 Mbps data rate. The CRD4001-4001ER provides a maximum of 1 Gbps data rate.

• Simultaneously charges up to four wearable terminals (with batteries installed).

The user cannot ActiveSync using the Four Slot Ethernet cradle. To ActiveSync with a host computer, use the 
Single Slot USB cradle.

Figure 2-5    Four Slot Ethernet Cradle

CRD4000-4000ER Setup

To setup the Ethernet cradle:

1. Connect one end of an Ethernet cable to a Ethernet switch, router or hub.

2. Connect the other end of the Ethernet cable to the Ethernet Port 1 on the back of the cradle.

3. Connect the DC cable to the output of the power supply.

4. Connect the DC cable to the power input on the back of the cradle.

5. Plug the AC line cord into the power supply.

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 
9-3.

Yellow Link LED (CRD4000-4000ER)
Green Right LED (CRD4001-4000ER)

Green Speed LED (CRD4000-4000ER)
Green Left LED (CRD4001-4000ER)
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6. Plug the AC line cord into an AC outlet.

Figure 2-6    CRD4000-4000ER Four Slot Ethernet Cradle Setup

Daisychaining CRD4000-4000ER Cradles

To connect several cradles to an Ethernet network, up to four Ethernet cradles may be daisychained. 
Daisy-chaining should not be attempted when the main Ethernet connection to the first cradle is 10 Mbps as 
throughput issues will certainly result. The Speed LED and the Link LED on the Ethernet port 2 function in the 
same way as the Speed LED and the Link LED on the front of the cradle.

To daisychain cradles:

1. Connect one end of the daisychain Ethernet cable (either straight or twisted cable can be used) to the 
Ethernet Port 2 port of the first cradle.

2. Connect the other end of the Ethernet cable to the Ethernet Port 1 port on the second cradle.

3. Connect additional cradles as described in step 1 and 2.

Power PortEthernet Port 1

Ethernet Switch, Router
or Hub Connection

AC Line Cord

Ethernet Cable DC Power Cable

Power Supply
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Figure 2-7    Daisychaining Four Slot Ethernet Cradles

LED Indicators (CRD4000-4000ER)

There are two LEDs on the front of the cradle and two on the Ethernet 2 port. The green Speed LED lights to 
indicate that the transfer rate is 100 Mbps. When the LED is not lit the transfer rate is 10 Mbps. The yellow Link 
LED blinks to indicate activity, or stays lit to indicate that a link is established. When it is not lit it indicates that 
there is no link.

CRD4001-4000ER Setup

To setup the Ethernet cradle:

1. Connect one end of an Ethernet cable to a Ethernet switch, router or hub.

2. Connect the other end of the Ethernet cable to the Primary Port on the back of the cradle.

3. Connect the DC cable to the output of the power supply.

Ethernet Port 1

Ethernet Port 2

Link LED

Speed LED 

1st Cradle

2nd Cradle

Ethernet Cable

Table 2-3    CRD4000-4000ER LED Indicators

Data Rate Speed LED Link LED

100 Mbps On On/Blink

10 Mbps Off On/Blink
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4. Connect the DC cable to the power input on the back of the cradle.

5. Plug the AC line cord into the power supply.

6. Plug the AC line cord into an AC outlet.

Figure 2-8    CRD4001-4000ER Four Slot Ethernet Cradle Setup

Daisy-chaining CRD4001-4000ER Cradles

To connect several cradles to an Ethernet network, up to four Ethernet cradles may be daisychained. 
Daisy-chaining should not be attempted when the main Ethernet connection to the first cradle is 10 Mbps as 
throughput issues will certainly result. The LEDs on the Primary Ethernet port function in the same way as the 
LEDs on the front of the cradle.

To daisychain cradles:

1. Lift or remove the label covering the Secondary Port on the back of the first cradle.

2. Connect one end of the daisychain Ethernet cable (either straight or twisted cable can be used) to the 
Secondary Port of the first cradle.

3. Connect the other end of the Ethernet cable to the Primary Port of the second cradle.

4. Connect additional cradles as described in steps 1 and 2.

Power Port

Primary Port

Ethernet Switch, Router or 
Hub Connection

AC Line Cord

Ethernet Cable
DC Power Cable

Power Supply

Right LEDLeft LED
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Figure 2-9    Daisychaining Four Slot Ethernet Cradles

LED Indicators (CRD4001-4000ER)

There are two green LEDs on the front of the cradle and two green LED on the Primary Ethernet port. These 
green LEDs light and blink to indicate the data transfer rate. When the LEDs are not lit the transfer rate is 10 
Mbps.

Ethernet Cradle Drivers

The Ethernet cradle drivers are pre-installed on the wearable terminal and initiate automatically when the 
wearable terminal is placed in a properly connected Four Slot Ethernet cradle. When the wearable terminal is 
inserted into the Four Slot Ethernet cradle, the LAN icon appears in the taskbar and indicates that the wearable 
terminal is connected to a network.

Secondary Port

Primary Port

1st Cradle

2nd Cradle

Ethernet Cable
To Power Supply

To Power Supply

To Ethernet Switch

Label

Primary Port

Table 2-4    CRD4001-4000ER LED Indicators

Data Rate Left LED Right LED

1 Gbps On/Blink Off

100 Mbps Off On/Blink

10 Mbps Off Off
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On a touch screen WT41N0, to view the IP Address double-tap the LAN icon to open the SS1VNDIS1 window. 
The window displays the TCP/IP information for the WT41N0.

On a non-touch WT41N0, to view the IP Address assigned to the WT41N0 open a Command Prompt window 
and enter ipconfig.

1. Press CTRL > ESC.

2. Use the navigation keys to select Programs.

3. Press ENTER to open the sub-menu.

4. Use the navigation keys to select Command Prompt.

5. Press ENTER. The Command Prompt window displays.

6. Enter ipconfig. The window displays the IP Address assigned to the wearable terminal.

Figure 2-10    Ethernet IP Address

NOTE The device’s IP address can only be viewed on the WT41N0.
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Charging and Communication

Figure 2-11    Four Slot Ethernet Cradle

Battery Charging Indicators

The wearable terminal’s amber Charge Status LED shows the status of the battery charging in the wearable 
terminal. See Table 1-1 on page 1-5 for charging status indications. The standard capacity battery usually 
charges in less than four hours and the extended capacity battery usually charges in less than eight hours.
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Four Slot Spare Battery Charger

This section describes how to set up and use the Four Slot Spare Battery Charger to charge up to four spare 
batteries.

Figure 2-12    Four Slot Spare Battery Charger Setup

Spare Battery Charging

1. Connect the charger to a power source.

2. Insert the battery into a spare battery charging slot and press down on the battery to ensure proper 
contact.

Figure 2-13    Spare Battery Charging

CAUTION Ensure that you follow the guidelines for battery safety described in Battery Safety Guidelines on page 
9-3.

CAUTION Use only a Zebra approved power supply output rated 12 VDC and minimum 3.3 A. Use of an 
alternative power supply will void the product warranty and may cause product damage. Refer to the 
WT41N0 User Guide for the power supply regulatory compliance statement.

Spare Battery Charge 
Status LEDs (4)

Spare Battery Charging Well (4)



2 - 14 WT41N0 Integrator Guide
Battery Charging Indicators

Each battery charging well has an amber Spare Battery Charge Status LED. (see Figure 2-13 on page 2-13). 
See Table 2-5 for charging status indications.

The standard capacity battery usually charges in less than four hours and the extended capacity battery 
usually charges in less than eight hours.

Table 2-5     Spare Battery Charge Status LED Indicators

LED Indication

Off No spare battery in slot; spare battery not placed correctly; cradle is not powered.

Fast Blinking Amber Charging error:

• Temperature is too low or too high.
• Charging has gone on too long without completing (typically eight hours).

Slow Blinking Amber Spare battery is charging.

Solid Amber Charging complete.
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Wall Mount Bracket
Use the wall mounting bracket to mount a Four Slot Ethernet cradle and a Four Slot Battery Charge together 
on a wall.

To mark the screw holes for mounting the bracket use the wall mounting bracket as a template. Place the 
bracket onto the wall, level and mark the five screw hole locations.

1. Install top three screws into the wall.

2. Align the top three mounting holes with the screws.

3. Place mounting bracket on screws.

4. Secure the mounting bracket to the wall by tightening the three screws.

5. Install and secure two screws at the bottom of the bracket.

Figure 2-14    Mounting the Bracket

Right Cable Slot

Left Cable Slot

Power Supply Mounting Shelf

Charger Mounting Studs

Cradle Alignment Tab



2 - 16 WT41N0 Integrator Guide
Power Supply Installation

Place power supply onto mounting shelf with the DC output connector and fan facing out and with the fan on 
top.

Figure 2-15    Installing the Power Supply

Power Supply Fan

DC Output
Connector

Power Supply
Air Holes
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Four Slot Ethernet Cradle Installation

1. Align the two slots in the back of the cradle with the two cradle alignment tabs on the bracket.

Figure 2-16    Aligning the Slots in the Cradle with Mounting Bracket Tabs

2. Secure the cradle to the mounting bracket with two M4.0 screws supplied with the bracket.

Cradle Alignment Tab

Cradle Slots
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Figure 2-17    Securing the Four-Slot Ethernet Cradle to the Mounting Bracket
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Four Slot Battery Charger Installation

The Four Slot Spare Battery Charger has four mounting slots on the back. Around the slots are guides that 
assist in proper alignment of the charger onto the mounting bracket. Gravity holds the charger in place.

Figure 2-18    Installing the Battery Charger onto the Mounting Bracket

Position the charger over the mounting studs and slide the charger into place.

Ensure that the charger is seated properly.

Wiring

The AC line cord provides AC power to the power supply. The mounting bracket power cable provides power 
from the power supply to the Four Slot Ethernet cradle and the Four Slot Spare Battery Charger. Ethernet 
cables (not supplied) connects the cradle to the local network and to another cradle, if required.

Ensure that the AC line cord is long enough to reach from the AC power source to the power supply.

1. Route the AC line cord through the right cable slot of the bracket.

2. Plug the AC line cord into the power supply AC input connector.

3. Route the power supply connector of the power cable through the cradle channel and out the left side of 
the cradle.

4. Plug the power cable connector into the DC output connector on the power supply.

5. Plug the cradle power plug into the Four Slot Ethernet cradle input power connector.

6. Plug the charger power plug onto the Four Slot Spare battery Charger input power connector.

7. Plug one end of the Ethernet cable into the appropriate connector on the Four Slot Ethernet cradle.

8. Route the cables as shown in Figure 2-19 and Figure 2-20.

9. Use two tie-wraps to secure the power cable Y connection to the power supply mounting shelf.

Mounting Studs

Mounting Slots



2 - 20 WT41N0 Integrator Guide
Figure 2-19    Cable Routing

10. Use one tie-wrap to secure the AC line cord and Ethernet cable to the mounting bracket.

11. Use two tie-wraps to secure the charger power lead, the AC line cord and Ethernet cable (if required) 
together as shown below.

Figure 2-20    Routing Cables

12. Plug the AC line cord into an AC power source.

Cradle Power Plug

Right Cable Slot

Charger 
Power Plug

Tie-Wraps

Ethernet Cable Plug

AC Line CordTie-Wraps

Tie-Wrap

Charger Power Lead Ethernet Cable



Accessories 2 - 21
Placing a Battery in the Charger

When placing a spare battery into the Four Slot Spare Battery Charger, ensure proper orientation of the battery.

Figure 2-21    Inserting a Battery into the Battery Charger

Mounting Multiple Brackets

When installing multiple brackets on a wall:

• Each mounting bracket must be 25.4 cm (10 in.) from the top of one bracket to the top of the next 
bracket.

• The bottom of the last bracket must be at least 61 cm (24 in.) from the floor.

• When mounting brackets next to each other the tabs must at least touch each other to ensure minimum 
distance between brackets.
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Figure 2-22    Installing Multiple Mounting Brackets

61 cm
24 in.

25.4 cm
10 in.

Position Tabs 
Together to Ensure 
Minimum Distance
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Navigating the Wearable Terminal with an External Input Device
To assist in development, an external input device, such as a mouse, can be used to navigate the desktop and 
applications instead of using the wearable terminal keypad.

• USB devices

• mouse

• keyboard

• hub

• Bluetooth mouse.

USB Device

The following is required to connect a USB device:

• a commercially-available USB cable or Zebra’s USB Adapter with a mini USB A connector on one end 
and a USB A Female connector on the other end.

• a USB device

• a USB keyboard

• a USB mouse

• a USB hub (optional).

Connect the mini USB A connector end into the USB connector on the back of the Single Slot USB cradle. The 
cradle automatically detects the USB A connector and places the wearable terminal into USB host mode. 
Connect the USB device (mouse or keyboard) connector into the USB A Female connector. You can also 
connect both a mouse and keyboard to a hub and the hub to the USB A Female connector.

Figure 2-23    USB Mouse Connection to the Single Slot USB Cradle

NOTE The wearable terminal must be inserted into the Single Slot USB cradle to use a USB input device.

Mini USB A

USB A Female

USB Mouse

USB Cable
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Figure 2-24    USB Keyboard Connection to the Single Slot USB Cradle

Figure 2-25    USB Mouse/Keyboard/Hub Connection to the Single Slot USB Cradle

Mini USB A

USB A Female

USB Keyboard

USB Cable

Mini USB A

USB A FemaleUSB Hub

USB Mouse

USB Keyboard

USB Cable
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Connector Shroud

Assembly

1. Remove cable from wearable terminal, if required.

2. Align the cable connector with the connector shroud bottom housing. Ensure that the disconnect button on 
the connector faces up.

Figure 2-26    Installing Bottom Housing

3. Place the cable connector into the shroud bottom housing as shown.

Figure 2-27    Installing Top Housing

4. Press the top housing into the bottom housing. The housings will snap together.

5. Plug the cable connector into the wearable terminal connector.

Disconnecting the Cable from the Wearable Terminal

1. Turn the wearable terminal over to expose the top housing of the shroud.

2. Push the tip of a ball-point pen through the hole in the connector shroud top housing. The connector 
disengages from the wearable terminal.

NOTE Use only on the RS409 or RS419 with extended cable.

Disconnect Button

Bottom Housing

NOTE Follow the instructions below when disconnecting the cable connector and shroud from the wearable terminal. 
Once the shroud is installed on the connector, do not disassemble the shroud by prying it apart.
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Figure 2-28    Disconnecting Connector with Shroud

Connector Eject Hole



CHAPTER 3 SYNCHRONIZATION
Introduction
Synchronization lets the user manage information between an WT41N0 and a host computer so that changes 
made either on the WT41N0 or on the host computer appear in both places. Download and install 
synchronization software to the host computer (either Microsoft ActiveSync for Windows XP or Windows 
Mobile Device Center (WMDC) for Windows Vista and Windows 7) in order to use the sync feature. Visit 
www.microsoft.com on the host computer for details.

The synchronization software:

• Allows working with WT41N0-compatible applications on the host computer. The sync software 
replicates data from the WT41N0 to view, enter, and modify data on the host computer.

• Synchronizes files between the WT41N0 and the host computer, converting the files to the correct 
format.

• Backs up the data stored on the WT41N0. Synchronization is a one-step procedure that ensures the data 
is always safe and up-to-date.

• Copies (rather than synchronizes) files between the WT41N0 and the host computer.

• Controls when synchronization occurs by selecting a synchronization mode. For example, synchronize 
continuously while the WT41N0 is connected to the host computer, or synchronize only on command.

• Selects the types of information to synchronize and control how much data is synchronized.

Installing the Sync Software

To download and install either Microsoft ActiveSync (for Windows XP) or WMDC (for Windows Vista and 
Windows 7), visit www.microsoft.com and follow the instructions provided.

WT41N0 Setup

NOTE Microsoft recommends installing the synchronization software on the host computer before connecting 
the WT41N0.
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The WT41N0 can be set up to communicate with a USB connection. The WT41N0 communication settings 
must be set to match the communication settings used with ActiveSync or WMDC.

1. On the WT41N0 tap Start > Settings > Control Panel > PC Connection. The PC Connection 
Properties window appears.

Figure 3-1    PC Connection Properties Window

2. Tap the Change Connection button.

3. Select the connection type from the drop-down list.

4. Tap OK to exit the Change Connection window and tap OK to exit the PC Connection Properties 
window.

5. Proceed with installing ActiveSync or WMDC on the host computer and setting up a partnership.

Setting Up a Sync Connection
Set up a Sync connection using Windows XP or Windows 7.

ActiveSync (Windows XP)

To set up a Sync connection using Windows XP:

1. Select Start > Programs > Microsoft ActiveSync on the host computer. The ActiveSync Window 
displays.

Figure 3-2    ActiveSync Window
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2. In the ActiveSync window, select File > Connection Settings. The Connection Settings window 
appears.

Figure 3-3    Connection Settings Window

3. Select Allow USB connections check box.

4. Select the Show status icon in taskbar check box.

5. Select OK to save any changes made.

Windows Mobile Device Center (Windows 7)

To set up a Sync connection using Windows 7:

1. Select Start > All Programs > Windows Mobile Device Center on the host computer.

Figure 3-4    Windows Mobile Device Center Window

2. In the WMDC window, under Mobile Device Settings, click Connection settings.

NOTE Assign each WT41N0 a unique device name. Do not try to synchronize more than one WT41N0 to the 
same name. 
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Figure 3-5    Connection Settings Window

3. Select Allow USB connections and adjust any additional settings as needed.

4. Click OK to save your settings.

Setting up a Partnership

To set up a partnership:

1. If the Get Connected window does not appear on the host computer, select Start > All Programs > 
Microsoft ActiveSync.

2. Select if you want to create synchronize with the host computer or to connect as a guest.

3. Click Next.

Figure 3-6    Select Synchronization Setting Window

4. Select the appropriate settings and click Next.

ActiveSync WMDC
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Figure 3-7    Setup Complete Window

5. Click Finish or Setup.

Figure 3-8    Connected Window

During the first synchronization, information stored on the WT41N0 is copied to the host computer. When the 
copy is complete and all data is synchronized, the WT41N0 can be disconnect from the host computer.

For more information about using ActiveSync or WMDC, start the application on the host computer, then see 
Help.

ActiveSync WMDC

ActiveSync WMDC

NOTE The first synchronization operation must be performed with a local direct connection. To retain 
partnerships after a cold boot, capture partnership registry information in a .reg file and save it in the 
Flash File System, detailed information is provided in the EMDK Windows CE Help File for the Zebra 
WT41N0.
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CHAPTER 4 VOICE ONLY WT41N0 
REMOTE CONTROL
Introduction
Since the Voice Only WT41N0 does not have a display, access to settings and controls must be done using a 
remote display software, such as MotoRC or ActiveSync Remote Display.

MotoRC Software

Download the MotoRC application from the Zebra Support Central web site: http://www.zebra.com/support. 
Follow the instructions provided with the software to install on a host computer.

Microsoft ActiveSync Remote Display Software

Download Windows Mobile Power Toys from the Microsoft web site: http://www.microsoft.com. Follow the 
instructions with the software to install on a host computer.

Ensure that ActiveSync is installed on the host computer. See Chapter 3, Synchronization for more 
information.

Connection to Host Computer
To connect the Voice Only WT41N0 to a host computer:

1. Connect the Single Slot Serial/USB cradle to the host computer. See Single Slot USB Cradle on page 2-3 
for setup instructions.

2. Insert the Voice Only WT41N0 into the cradle.

3. If ActiveSync was installed properly, the host computer automatically detects the Voice Only WT41N0 and 
begins ActiveSync. The ActiveSync windows appears.

4. Select the Yes radio button to create a partnership with the host computer or select No radio button to 
connect as a guest.

5. Click Next. The Microsoft ActiveSync window indicates that it is connected to the Voice Only WT41N0.

http://www.zebra.com/support
http://www.microsoft.com
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MotoRC Connection

To control the Voice Only WT41N0 using the MotoRC software:

1. On the host computer, click Start > Programs > MSP > MotoRC > Run Remote Control. The Run 
Remote Control DOS window opens followed by the Remote Control window.

Figure 4-1    Remote Control Window

2. Click on the UI Control icon to display the Voice Only WT41N0 desktop.

UI Control Icon
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Figure 4-2    Remote Control Window with Voice Only WT41N0 Desktop

3. Use the host computer mouse to control the Voice Only WT41N0 desktop.

4. When finished, close the Remote Control and Run Remote Control window.

Microsoft ActiveSync Remote Display Connection

To control the Voice Only WT41N0 using the Microsoft ActiveSync Remote Display software:

1. On the host computer, click Start > Programs > ActiveSync Remote Display. The ActiveSync Remote 
Display window displays with the Voice Only WT41N0 desktop shown.

Figure 4-3    ActiveSync Remote Display Window

2. Use the host computer mouse to control the Voice Only WT41N0 desktop.

3. When finished, close the ActiveSync Remote Display window.
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CHAPTER 5 WIRELESS APPLICATIONS
Introduction
Wireless Local Area Networks (LANs) allow mobile computers to communicate wirelessly and send captured 
data to a host device in real time. Before using the WT41N0 on a WLAN, the facility must be set up with the 
required hardware to run the wireless LAN and the WT41N0 must be configured. Refer to the documentation 
provided with the access points (APs) for instructions on setting up the hardware.

To configure the WT41N0, a set of wireless applications provide the tools to configure and test the wireless 
radio in the WT41N0. Refer to the Wireless Fusion Enterprise Mobility Suite User Guide for Version X2.00 for 
information on configuring wireless profiles. Go to http://www.zebra.com/support for the latest version of this 
guide. See Software Versions on page xii to determine the Fusion version on the WT41N0.

Tap the Signal Strength icon to display the Wireless Launcher menu.

Figure 5-1    Wireless Launcher Menu

Many of the items in the menu invoke one of the Fusion applications. These menu items and their 
corresponding applications are summarized in Table 5-1.

NOTE 802.11d is enabled by default. When enabled, the AP must be configured the same in order to 
connect.

Signal Strength Icon

http://www.zebra.com/support
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Additional Wireless Launcher menu entries include:

• Enable/Disable Radio

• Hide Menu

• Exit.

Signal Strength Icon
The Signal Strength icon in the task tray indicates the mobile computer’s wireless signal strength as follows:

Table 5-1    Supported Applications

Application Description

Find WLANs Invokes the Find WLANs application which displays a list of the WLANs available 
in your area.

Manage Profiles Invokes the Manage Profiles application (which includes the Profile Editor 
Wizard) to manage and edit your list of WLAN profiles.

Manage Certs Invokes the Certificate Manager application which allows you to manage 
certificates used for authentication.

Manage PACs Invokes the PAC Manager application which helps you manage the list of 
Protected Access Credentials used with EAP-FAST authentication.

Options Invokes the Options application which allows you to configure the Fusion option 
settings.

Wireless Status Invokes the Wireless Status application which allows you to view the status of the 
current wireless connection.

Wireless Diagnostics Invokes the Wireless Diagnostics application which provides tools with which to 
diagnose problems with the wireless connection.

Log On/Off Invokes the Network Login dialog which allows you to log on to a particular profile 
or to log off from the currently active profile.

Table 5-2    Signal Strength Icons Descriptions

Icon Status Action

Excellent signal strength WLAN network is ready to use.

Very good signal strength WLAN network is ready to use.

Good signal strength WLAN network is ready to use.

Fair signal strength WLAN network is ready to use. Notify the network administrator 
that the signal strength is only “Fair”.

Poor signal strength WLAN network is ready to use. Performance may not be 
optimum. Notify the network administrator that the signal 
strength is “Poor”.
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Turning the Radio On and Off
By default, the WLAN radio is on.

On a WT41N0 with Touch Screen

To turn off the WLAN radio, tap the Signal Strength icon in the task tray and select Disable Radio.

Figure 5-2    Signal Strength Icon

To turn the radio on, tap the Signal Strength icon in the task tray and select Enable Radio.

On a WT41N0 with Non-touch Screen

To turn off the WLAN radio:

1. Press ALT > W. The Fusion menu appears.

2. Use the navigation keys to select Disable Radio.

3. Press ENTER.

Figure 5-3    Fusion Menu

To turn on the WLAN radio:

1. Press ALT > W.

Out-of-network range (not 
associated)

No WLAN network connection. Notify the network administrator.

The WLAN radio is disabled. The WLAN radio is disabled. To enable, choose Enable Radio 
from the Wireless Applications menu.

None The Wireless Launcher 
application was exited.

 The Wireless Launcher application has been closed. See the 
Fusion Functions paragraphs below for how to restart the 
Wireless Launcher.

Table 5-2    Signal Strength Icons Descriptions (Continued)

Icon Status Action

Signal Strength Icon
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2. Use the navigation keys to select Enable Radio.

3. Press ENTER.

Minimum Setup
Below is a list of the minimum effort to achieve a wireless connection. Note that there are many discrete 
nuances that may affect the performance of your wireless connection that might be missed if you do not 
consider them carefully.

You will need to create a profile. It is recommended that you read the profile editor chapter.

1. Find out from your IT administrator what the connection settings should be (Extended Service Set Identifier 
(ESSID), Enterprise or Personal, authentication type, tunnel type, certificate requirements, Protected 
Access Credentials (PAC) requirements). Note that not all of the items listed may be relevant.

2. Create the profile using the information provided by the IT administrator.

3. Enter the Manage Profile screen, select the profile (press and hold), and select the Connect option in the 
context menu that appears.



CHAPTER 6 BLUETOOTH
Introduction

Bluetooth-equipped devices can communicate without wires, using frequency-hopping spread spectrum 
(FHSS) RF to transmit and receive data in the 2.4 GHz Industry Scientific and Medical (ISM) band (802.15.1). 
Bluetooth wireless technology is specifically designed for short-range (30 feet/10 meters) communications and 
low power consumption.

Wearable terminals with Bluetooth capabilities can exchange information (e.g., files, appointments and tasks) 
with other Bluetooth enabled devices such as headsets, printers, access points and other wearable terminals.

Zebra wearable terminals with Bluetooth technology use the StoneStreet One Bluetooth stack. To program 
Bluetooth within the wearable terminal refer to the StoneStreet One SDK, available at the Zebra Support 
Central web site on the WT4100 product page.

Adaptive Frequency Hopping
Adaptive Frequency Hopping (AFH) is a method of avoiding fixed frequency interferers. AFH can be used with 
Bluetooth voice. All devices in the piconet (Bluetooth network) must be AFH-capable in order for AFH to work. 
There is no AFH when connecting and discovering devices. Avoid making Bluetooth connections and 
discoveries during critical 802.11b communications. AFH for Bluetooth can be broken-down into four main 
sections:

• Channel Classification - A method of detecting an interference on a channel-by-channel basis, or 
pre-defined channel mask.

• Link Management - Coordinates and distributes the AFH information to the rest of the Bluetooth network.

• Hop Sequence Modification - Avoids the interference by selectively reducing the number of hopping 
channels.

• Channel Maintenance - A method for periodically re-evaluating the channels.

NOTE The Voice Only WT41N0 requires the use of a Remote Desktop software to configure settings and 
software. See Voice Only WT41N0 Remote Control on page 4-1 for information on setting up the device 
with remote desktop software.
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When AFH is enabled, the Bluetooth radio “hops-around” (instead of through) the 802.11b high-rate channels. 
AFH coexistence allows Zebra wearable terminals to operate in any infrastructure. AFH is always enabled in 
the wearable terminal.

The Bluetooth radio in this wearable terminal operates as a Class 2 device power class. The maximum output 
power is 2.5mW and the expected range is up to 32.8 feet (10 meters). A definitive definition of ranges based 
on power class is difficult to obtain due to power and device differences, and whether one measures open 
space or closed office space.

Security
The current Bluetooth specification defines security at the link level. Application-level security is not specified. 
This allows application developers to define security mechanisms tailored to their specific need. Link-level 
security is really between devices not users, while application-level security can be implemented on a per-user 
basis. The Bluetooth specification defines security algorithms and procedures needed to authenticate devices, 
and if needed, encrypt the data flowing on the link between the devices. Device authentication is a mandatory 
feature of Bluetooth while link encryption is optional.

Pairing of Bluetooth devices is accomplished by creating an initialization key that is used to authenticate the 
devices and create a link key for them. Entering a common PIN number in the devices being paired generates 
the initialization key. The PIN number is never sent over the air. By default, the Bluetooth stack responds with 
no key when a key is requested (it is up to user to respond to the key request event). Authentication of 
Bluetooth devices is based-upon a challenge-response transaction. Bluetooth allows for a PIN number or 
passkey that is used to create other 128-bit keys used for security and encryption. The encryption key is 
derived from the link key used to authenticate the pairing devices. Also worthy of note is the limited range and 
fast frequency hopping of the Bluetooth radios that makes long-distance eavesdropping difficult.

It is recommended:

• Perform pairing in a secure environment

• Keep PIN codes private and don't store the PIN codes in the wearable terminal

• Implement application-level security.

Security Mode 3 (Link Level Encryption)

The wearable terminal supports Security Level 3 (Link Level Encryption). Link level encryption is the data 
security process of encrypting information at the data link level as it is transmitted between two devices.

Microsoft Bluetooth Stack

When pairing with a remote device using the Microsoft Bluetooth UI, Security Level 3 (Link Level Encryption) is 
automatically used. When developing applications using the Microsoft Bluetooth stack, enable Security Mode 3 
using the BthSetEncryption API call. Refer to the Microsoft MSDN for more information.

StoneStreet One Bluetooth Stack

To set Security Mode 3 on outgoing serial port connections, set Encrypt Link On All Outgoing Connections 
checkbox in the Settings > Security. See Security on page 6-2 for more information.

NOTE It is not recommended to perform Bluetooth wireless technology inquiry when high rate 802.11b 
operation is required.
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FIPS 140-2

The WT41N0 supports FIPS 140-2 for Bluetooth using the Microsoft Bluetooth stack and the StoneStreet One 
Bluetooth stack. FIPS provides secure Bluetooth communication between the WT41N0 and another mobile 
computer or scanner only using a Serial Port Profile.

Bluetooth Configuration
By default the wearable terminal is configured to use the StoneStreet One Bluetooth stack. Table 6-1 lists the 
services supported by the StoneStreet One Bluetooth stack and the Microsoft Bluetooth stack.

Table 6-2 lists the COM ports available for the StoneStreet One and Microsoft Bluetooth stacks.

Table 6-1    Bluetooth Services

Features Microsoft Bluetooth Stack StoneStreet One
Bluetooth Stack

GAP Profile Yes Yes

SDP Profile Yes Yes

Serial Port Profile (Server and Client) Yes Yes

Headset Profile (Audio Gateway) Yes Yes

Dialup Networking Profile (Client Role) No Yes

Generic OBEX push Profile No Yes

File Transfer Profile (Server Role) No Yes

File Transfer Profile (Client Role) No Yes

HID Profile No Yes

Table 6-2    COM Ports

Microsoft Bluetooth Stack StoneStreet One Bluetooth Stack

COM5 COM5

COM9 COM9

COM11

COM21

COM22

COM23



6 - 4 WT41N0 Integrator Guide
Bluetooth Power States

Cold Boot

When a cold boot is performed on the wearable terminal, Bluetooth turns off. It is normal to see the Bluetooth 
icon appear and disappear, as well as a wait cursor, when initialization proceeds in all modes.

Warm Boot

When a warm boot is performed on the wearable terminal, Bluetooth returns to the previous state.

Suspend

When the wearable terminal suspends, Bluetooth turns off.

Resume

When the wearable terminal resumes, Bluetooth turns on if it was on prior to suspend. Note that any Bluetooth 
connection that was dropped during a suspend needs to be reconnected after a resume.

MotoBTUI Application
Use the MotoBTUI application to:

• Turn the Bluetooth radio on and off.

• View device information

• Control device status

• Generate a pairing bar code (Refer to the RS507 Product Reference Guide for more information).

• Configure FIPS key

• Discover and pair with other Bluetooth devices (using the Microsoft stack).

Figure 6-1    MotoBTUI Window

NOTE When the wearable terminal is placed in suspend mode, the Bluetooth radio mode powers off and the 
piconet (Bluetooth connection) is dropped. When the wearable terminal resumes, it could take up to 10 
seconds for the Bluetooth radio driver to re-initialize the radio.

Stone Street One Stack Microsoft Stack



Bluetooth 6 - 5
Device Information

The view the WT41N0 Bluetooth information:

1. Tap Start > Programs > MotoUI.

2. Tap My Device Information.

3. The Device Information window displays:

• Device Name

• HCI version number

• LMP version number

• Bluetooth chip manufacturer name

• BT UI version number.

4. Tap the Back button to return to the MotoBTUI window.

FIPS Configuration

To generate a new FIPS key automatically:

1. Tap Start > Programs > MotoUI.

2. Tap FIPS Configuration.

3. Tap Generate Key button.

4. Tap the SetUp Key button. A new key is generated. The key file, NewAESKey.reg, is created in the 
/Application folder.

5. Tap the Back button to return to the MotoBTUI window.

To generate a new FIPS key manually:

1. Tap Start > Programs > MotoUI.

2. Tap FIPS Configuration.

3. Tap Enter Key button.

4. In the text box, enter a key.

5. Tap the SetUp Key button. A new key is generated. The key file, NewAESKey.reg, is created in the 
/Application folder.

6. Tap the Back button to return to the MotoBTUI window.

To transfer the new FIPS key to another Bluetooth device:

1. Copy the NewAESKey.reg file from the WT41N0 to the other Bluetooth device. Place the file into the 
/Application folder.

2. Navigate to the /Application folder.

NOTE By default the WT41N0 has a FIPS key installed. If required, the user can generate a new FIPS 
key. If a new key is generated on the WT41N0, the same key is required to be used on the 
other Bluetooth device. The user must transfer the key to the other device.
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3. Locate the NewAESKey.reg file and tap the filename. The RegMerge confirmation box displays.

4. Tap Yes.

5. Perform a warm boot.

Device Status

Use the Device Status option to set if the WT41N0 would be seem by other Bluetooth devices. Select the 
Device Status option to toggle the WT41N0 from Hidden to Discoverable.
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Using the StoneStreet One Bluetooth Stack
The BTExplorer application can be accessed from the App Launcher menu or by a key combination.

Turning the Bluetooth Radio Mode On and Off

Turn off the Bluetooth radio to save power or if entering an area with radio restrictions (e.g., an airplane). When 
the radio is off, the wearable terminal can not be seen by or connected to other Bluetooth devices. Turn on the 
Bluetooth radio to exchange information with other Bluetooth devices (within range). Communicate only with 
Bluetooth radios in close proximity.

Disabling Bluetooth

To disable Bluetooth, press ALT - B. Use the navigation keys to select Disable Bluetooth. Press ENTER. An 
exclamation point appears on the Bluetooth icon indicating that the Bluetooth radio is disabled.

 

Figure 6-2    Disable Bluetooth

Enabling Bluetooth

To enable Bluetooth, press ALT - B. Use the navigation keys to select Enable Bluetooth. Press ENTER. The 
Bluetooth icon changes to indicate that Bluetooth is enabled.

Figure 6-3    Enable Bluetooth

NOTE To achieve the best battery life in wearable terminals with multiple radios, turn off the radios that are not 
being used. 
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Using App Launcher

In the App Launcher main menu, press 4 to select Utilities. Press 3 to select BT Explorer.

Figure 6-4    App Launcher Screens

Using Key Combination

Press ALT - B. Use the navigation keys to select Show BTExplorer.

Using Screen Touch

Touch the Bluetooth icon in the task tray and select Show BTExplorer.

BTExplorer Non-touch Display Navigation

The WT41N0 with non-touch display is a key-based device and navigation within the BTExplorer application is 
performed using the keypad.

Refer to the WT41N0 User Guide for detailed information on keypad navigation.

Key Combinations

The wearable terminal with non-touch display uses special key combinations to easily navigate applications. 
Table 6-4 lists the key combinations required to perform various application navigation and control functions.

NOTE App Launcher is not available on the Voice Only WT41N0.

Table 6-3    Function Keys

Action Key Key Combination

ALT Blue key - CTRL

MENU Blue key - TAB

SPACE Blue key - BKSP

Left arrow Blue key - up arrow

Right arrow Blue key - down arrow
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Discovering Bluetooth Device(s)

The wearable terminal can receive information from discovered devices, without pairing. However, once 
paired, an exchange of information between the wearable terminal and a paired device occurs automatically 
when the Bluetooth radio is turned on.

To find Bluetooth devices in the area:

1. Ensure that Bluetooth is enabled on both devices.

2. Ensure that the Bluetooth device being looked for is in discoverable and connectable mode.

3. Ensure that the required profile is enabled on the WT41N0. See Profiles on page 6-29 for more 
information.

4. Ensure that the two devices are within 30 feet (10 meters) of one another.

5. Access BTExplorer. See Using the StoneStreet One Bluetooth Stack on page 6-7.

6. From the Favorite window:

a. Press ALT - F to open the File menu.

b. Use the navigation keys to select New Connection and press ENTER. The New Connection Wizard 
window appears.

Table 6-4    Key Combinations

Action Combination

Access the Start menu on the taskbar CTRL - ESC

Switch fields within an application TAB

Close windows or cancel operations on some applications ESC or ALT - F4

Access the Task Manager ALT - TAB

Switches to the next window or desktop ALT - ESC

Access a menu bar in an application ALT - CTRL

Press a button or select a check box in an application TAB until the item is highlighted then SPACE.

Display a pop-up context menu MENU

CTRL - TAB

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite 
connections have been created, the New Connection Wizard screen displays.
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Figure 6-5    New Connection Wizard Window

7. Use the navigation keys to select Explore Services on Remote Device.

The following actions are available in the drop-down list (actions may vary depending upon configurations):

• Explore Services on Remote Device

• Pair with a Remote Device

• Active Sync via Bluetooth

• Browse Files on Remote Device

• Connect to Headset

• Connect to Internet using Access Point

• Connect to Internet using Phone/Modem

• Connect to Personal Area Network

• Connect to Printer

• Send or Exchange Objects

• Associate Serial Port.

8. Press ENTER. BTExplorer searches for Bluetooth devices in the area and displays the devices in the 

Select Remote Device window.

Figure 6-6    Device Discovery Dialog Box

NOTE If a device discovery action has not been previously performed, a device discovery is automatically 
initiated. If a device discovery has previously been performed, the device discovery process is skipped, 
and the previously found list of devices displays. To start a new device discovery, press Menu select 
Discover Devices from the menu and press ENTER.
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Figure 6-7    Select Remote Device Window

9. Use the navigation keys to select a device from the list and press ENTER. The wearable terminal searches 
for services on the selected Bluetooth device.

Figure 6-8    Device Services

10. Use the navigation keys to select a service from list and press ENTER. The Connection Favorite 
Options window appears.

Figure 6-9    Connection Favorite Options Window

11. Press TAB to highlight the Favorite Name text box, enter a name for this service that will appear in the 
Favorite window.

12. Press ENTER. The Connection Summary window appears.

NOTE To filter devices in the list press ALT - F to open the filter menu. Select a device type and then press 
ENTER.

To change the display view press ALT - V to open the view menu. Select a view type and then press 
ENTER.
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Figure 6-10    Connection Summary Window

13. Press P2 to add the service to the Favorite window.

14. The Favorite window appears and the wearable terminal connects to the remote device.

Figure 6-11    Favorite Window with Active Connection

Available Services

Some examples of available services are:

• File Transfer Services

• Headset Services

• OBEX Object Push Services

• Serial Port Services

• Personal Area Network Services

• HID Services.

These services are discussed in the following paragraphs.

File Transfer Services

To transfer files between the wearable terminal and another Bluetooth enabled device:

1. In the Favorite window, use the navigation keys to select the file transfer service.

2. Press MENU and select Connect from the pop-up menu.

3. Press ENTER. The File Transfer window appears listing the folders of the remote device.

NOTE Shared folders are a security risk.
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Figure 6-12    File Transfer Window

4. Use the navigation keys to select a file. To open a folder press ENTER.

5. Press ENTER to copy the file from the remote device. The Save Remote Device window appears.

Figure 6-13    Save Remote File Window

6. Press TAB three times to enter the folder area.

7. Use the navigation keys to select a folder to place the file into.

8. Press ENTER.

9. Press ENTER to save the file.

10. Select the action to perform:

a. New - create a new file or folder on the remote device.

b. Delete - delete the selected file on the remote device.

c. Get File - copy the file from the remote device to the wearable terminal.

d. Put File - copies a file from the wearable terminal to the remote device.

e. Parent Directory - opens the higher level folder.

f. Refresh - re-displays the files in the current folder.

Create New File or Folder

To create a new folder or file on the remote device:

1. Press MENU to open the pop-up menu.

2. Use the navigation keys to select New.

3. Press the right arrow to open the sub-menu.

4. Use the navigation keys to select Folder or File.
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5. Press ENTER. The Create New Folder or Create New File window appears.

Figure 6-14    Create New Folder Window

6. Enter a new name for the new folder or file and then press ENTER.

7. A new folder or file is created on the remote device.

Delete File

To delete a file from the remote device:

1. Use the navigation keys to select the file to delete.

2. Press MENU to open the pop-up menu.

3. Use the navigation keys to select Delete.

4. Press ENTER. A Delete Remote Device File dialog box appears.

5. Press ENTER to delete the file.

Get File

To copy a file from a remote device to the wearable terminal:

1. Press MENU to open the pop-up menu.

2. Use the navigation keys to select Get File.

3. Press ENTER. The Save Remote File window appears.

Figure 6-15    Save Remote File Window

4. Press TAB three times to enter the folder area.

5. Using the navigation keys to highlight a folder and press ENTER. The OBEX Object Push window 
appears.

6. Press ENTER. The file is transferred from the remote device to the wearable terminal.
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Put File

To copy a file from the wearable terminal to a remote device:

1. In the File Transfer window, navigate to a folder where the file will be put into.

2. Press MENU to open the pop-up menu.

3. Use the navigation keys to select Put File.

4. Press ENTER. The Send Local File window appears.

Figure 6-16    Send Local File Window

5. Press TAB three times to enter the folder area.

6. Select a file in the wearable terminal.

7. Press ENTER. The Sending Local File window appears.

Figure 6-17    Sending Local File Window

8. The file is transferred from the wearable terminal to the remote device.

Connect to Internet Using Access Point

This section explains how to access a Bluetooth-enabled LAN access point (AP) for a network connection. 
With this method of communication the Internet Explorer can be used to connect to a server.

1. In the Favorite window, use the navigation keys to select the LAN Access service.

2. Press MENU and select Connect from the pop-up menu.

3. Press ENTER.

4. The wearable terminal connects with the Access Point.

5. Press CTRL - ESC to open the Start menu.

6. Use the navigation keys to select Internet Explorer.
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7. Press ENTER. The Internet Explorer window appears.

8. In the address field, enter an internet address and tap the Enter button. The web page loads.

OBEX Object Push Services

Object Exchange (OBEX) is a set of protocols allowing pictures to be shared using Bluetooth. To send a picture 
to another device:

1. In the Favorite window, use the navigation keys to select the OBEX Push service.

2. Press MENU and select Connect from the pop-up menu.

3. Press ENTER. The OBEX Object Push window appears.

Figure 6-18    OBEX Object Push Window

4. Press TAB twice to highlight the  button.

5. Press SPACE.

6. The Send Local Picture window appears.

Figure 6-19    Send Local Picture Window

7. Press TAB three times to enter the folder area.

8. Using the navigation keys to highlight a file and press ENTER. The OBEX Object Push window appears.

To open a folder, highlight the folder and press ENTER.

9. Press ENTER. The wearable terminal connects to the remote device and begins to send the file. The 
Sending Picture window appears. When the file transfer is complete a confirmation dialog appears. Press 
ENTER.
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Figure 6-20    Sending Picture Window

Headset Services

To connect to a Bluetooth headset:

1. In the Favorite window, use the navigation keys to select the headset service.

2. Press MENU and select Connect from the pop-up menu.

3. Press ENTER.

4. The wearable terminal connects to the headset. Refer to your headset user manual for instruction on 
communicating with a Bluetooth device.

Serial Port Services

Use the wireless Bluetooth serial port connection just as you would a physical serial cable connection. You 
must configure the application that will use the connection to the correct serial port.

To establish a serial port connection:

1. In the Favorite window, use the navigation keys to select the Serial Port service.

2. Press MENU and select Connect from the pop-up menu.

3. Press ENTER.

4. The Remote Service Connection window appears.

Figure 6-21    Remote Service Connection Window

5. In the Local COM Port drop-down list select a COM port.

6. Press ENTER.

NOTE By default, COM ports COM4, COM5 and COM9 are Bluetooth virtual ports. If an application opens one 
of these ports, the Bluetooth driver activates and guides you through a Bluetooth connection.



6 - 18 WT41N0 Integrator Guide
Personal Area Network Services

Connect two or more Bluetooth devices to share files and collaborate.

To establish a Personal Area Network connection:

1. In the Favorite window, use the navigation keys to select the Personal Area Network service.

2. Press MENU and select Connect from the pop-up menu.

3. The wearable terminal connects to the Personal Area Network.

HID Services

Connect input devices such as Bluetooth keyboards and mice to the wearable terminal.

To establish a HID connection:

1. In the Favorite window, use the navigation keys to select the HID service.

2. Press MENU and select Connect from the pop-up menu.

3. The wearable terminal connects to the HID device.

Bonding with Discovered Device(s)

A bond is a relationship created between the wearable terminal and another Bluetooth device in order to 
exchange information in a secure manner. Creating a bond involves entering the same PIN on the two devices 
to bond. Once a bond is created, and the Bluetooth radios are turned on, the devices recognize the bond and 
are able to exchange information without re-entering a PIN.

To bond with a discovered Bluetooth device:

1. Access BTExplorer. See Using the StoneStreet One Bluetooth Stack on page 6-7.

2. Press ALT - F to open the File menu.

3. Use the navigation keys to select New Connection and press ENTER. The New Connection Wizard 
window appears.

Figure 6-22    New Connection Wizard Window

4. Use the navigation keys to select Pair with Remote Device.

5. Press ENTER. The BTExplorer searches for Bluetooth devices in the area and displays the devices in the 
Select Remote Device window.

NOTE If favorite connections have already been created, the Favorites screen displays. If no favorite 
connections have been created, the New Connection Wizard screen displays.
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Figure 6-23    Select Remote Device Window

6. Use the arrow keys to select a device from the list and press ENTER. The PIN Code Request window 
appears.

Figure 6-24    Connection Favorite Options Window

7. In the PIN Code field, enter the PIN code.

8. Press ENTER. The Pairing Status window displays.

Figure 6-25    Pairing Status Window

9. Press P2. The devices are successfully paired. The device name moves to the Trusted Devices window.

NOTE Devices discovered previously are listed to save time. To start a new device discovery, press Menu 
select Discover Devices from the menu and press ENTER.

NOTE To filter devices in the list press ALT - F to open the filter menu. Select a device type and then press 
ENTER.

To change the display view press ALT - V to open the view menu. Select a view type and then press 
ENTER.
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Accepting a Bond

When a remote device wants to bond with a wearable terminal, you give permission by entering a PIN when 
requested.

1. Ensure that the wearable terminal is set to discoverable and connectable. See Bluetooth Settings on page 
6-23.

2. When prompted to bond with the remote device the PIN Code Request window appears.

Figure 6-26    PIN Code Request Window

3. In the PIN Code: text box, enter the same PIN that was entered on the device requesting the bond. The 
PIN must be between 1 and 16 characters.

4. Press ENTER. The bond is created and the wearable terminal can now exchange information with the 
other device.

Trusted Devices Window

The Trusted Devices window lists all bonded devices. To access the Trusted Devices window:

1. Launch BTExplorer.

2. Press ALT - T.

3. Using the navigation keys select Trusted Devices.

4. Press ENTER. The Trusted Devices window appears.

Figure 6-27    Trusted Device Window

The Trusted Devices window contains one menu that can be accessed through key combinations. It allows 
you to change the window listing. To open the View menu press ALT - V. The menu drop-down list appears.

NOTE Connections to untrusted devices are a security risk.
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Figure 6-28    Trusted devices Window Menu

Use the navigation keys to select a view type and then press ENTER.

Deleting a Bonded Device

If it is no longer necessary to connect with a device, delete it from the Bluetooth Trusted Devices window.

1. Use the navigation keys to select a device.

2. Press MENU.

3. Use the navigation keys to select Delete Link Key.

4. Press ENTER. A confirmation dialog box appears.

5. Press ENTER to confirm deletion of the trusted device.

6. Press ENTER to exit the Trusted Device window.

Connecting to a Favorite Service

The Favorite window can display many services set as favorites. To connect to one of these services:

1. Use the navigation keys to select the service.

2. Press ENTER.

3. The wearable computer connects to the service. The service icon text becomes highlighted.

Figure 6-29    Favorite Window

To disconnect from a connected service:

1. Use the navigation keys to select the highlighted service.

2. Press MENU.

3. Use the navigation keys to select Disconnect.
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4. Press ENTER. A deaconate confirmation dialog box appears.

5. Select Yes to disconnect the service. The wearable computer disconnects from the service.

Navigating the Favorites Window

The Favorites window has three menus that can be accessed through key combinations.

Figure 6-30    Favorites Window Menus

To open the File menu, press ALT - F.

To open the View menu, press ALT - V.

To open the Tools menu, press ALT - T.

Delete all Favorite Services

To delete all favorites from the Favorites window:

1. Press ALT - F.

2. Use the navigation keys to select Delete All Favorites.

3. Press ENTER. A confirmation dialog box appears.

4. Press ENTER to confirm the deletion or ESC to cancel the deletion.

Delete a Favorite Service

To delete a selected favorite:

1. Use the navigation keys to select a favorite.

2. Press MENU. The pop-up menu appears.

3. Use the down arrow key to select Delete.

4. Press ENTER. A confirmation dialog box appears.

5. Press ENTER to confirm the deletion or ESC to cancel the deletion.

Rename a Favorite Service

To rename a favorite:

1. Use the navigation keys to select a favorite.

2. Press MENU.
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3. Use the down arrow key to select Rename.

4. Press ENTER. The Change Device Name window appears.

5. Enter a new name.

6. Press ENTER to change the name or ESC to cancel the name change.

Change the Display View

To change the display view:

1. Press ALT - V.

2. Use the down arrow key to select Large Icons, List or Details.

3. Press ENTER. The Favorite window layout changes.

View Active Connections

To view active connections:

1. Press ALT - T.

2. Use the down arrow key to select Active Connections.

3. Press ENTER. The Active Connections window appears.

4. Press ENTER to close the window.

View Properties

To view the properties of the wearable terminal:

1. Press ALT - T.

2. Use the down arrow key to select Local Device Properties.

3. Press ENTER. The Local Device Property window appears.

4. Press ENTER to close the window.

Bluetooth Settings

Use the BTExplorer Settings window to configure the operation of the BTExplorer application. To access the 
settings, press ALT - T, use the navigation keys to select Settings. Press ENTER. The BTExplorer Settings 
window appears.

Use the left and right arrows to move from one tab to the next. Within a tab, use the TAB key to move from one 
field to the next.

Device Info Tab

Use the Device Info tab to configure the wearable terminal’s Bluetooth connection modes.

NOTE To filter devices in the list press ALT - F to open the filter menu. Select a device type and then press 
ENTER.

To change the display view press ALT - V to open the view menu. Select a view type and then press 
ENTER.
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Figure 6-31    BTExplorer Settings - Device Info Tab

Press TAB to move to the next field.

Services Tab

Use the Services tab to management of the services the wearable terminal makes available for use by other 
Bluetooth devices.

Figure 6-32    BTExplorer Settings - Services Tab

To add a service:

1. Press TAB to highlight the Add key. Press SPACE. The Add Local Service window displays.

Table 6-5    Device Info Tab

Field Description

Device Name Displays the name of the wearable terminal. Not editable.

Discoverable Mode Allows you to set the wearable terminal to be discoverable by other Bluetooth devices or 
not be discoverable.

Note: For security reasons, the default is set to Non Discoverable.

Connectable Mode Allows you to set the wearable terminal to be connectable by other Bluetooth devices or 
not be connectable.

Note: For security reasons, the default is set to Non Connectable.

NOTE For security reason, by default services are not enabled.
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Figure 6-33    Add Local Service Window

2. In the list, use the navigation key to select a service to add.

3. Press ENTER to accept the service. Press ESC to exit without saving.

The Edit Local Service window displays for the selected service.

4. Select the appropriate information and then Press ENTER. See the following paragraphs for detailed 
information on the available services.

File Transfer Service

File transfer allows other Bluetooth devices to browse files.

Figure 6-34    BTExplorer Settings - File Transfer Information

Headset Audio Gateway Service

Headset Service Audio Gateway allows connection to headset devices.

Table 6-6    File Transfer Information Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, 
Authenticate, or Authenticate/Encrypt.

Root Directory Select the directory that other Bluetooth devices can access.

File Permissions Select the file permissions for the selected directory. Check the appropriate box 
to grant read access, write access, and delete access.
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OBEX Object Exchange Service

OBEX Object Exchange allows other Bluetooth devices to push contacts, business cards, pictures, 
appointments, and tasks to the WT41N0.

Personal Area Networking Service

Personal Area Networking hosts a Personal Area Network which allows communication with other Bluetooth 
devices.

Serial Port Service

Serial port allows other Bluetooth devices to access COM ports.

Table 6-7    Headset Audio Gateway Data

Item Description

Service Name Displays the name of the audio service.

Table 6-8    OBEX Exchange Information Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are 
None, Authenticate, or Authenticate/Encrypt.

Do not allow clients to push objects Disables clients from pushing objects to the WT41N0.

Inbox Directory Select a directory where another Bluetooth device can store files.

Business Card Select Contact entry.

Table 6-9    Personal Area Networking Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, 
Authenticate, or Authenticate/Encrypt.

Support Group Ad-Hoc 
Networking

Select to enable Ad-Hoc networking.
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Security

Security settings allows the user to set global security policies for Bluetooth. Note that these settings are only 
active on local Services that are set to Authenticate or Authenticate/Encryption. The user can set 
authentication on local Services under Services.

To adjust the security settings for an individual service, select Services first, then select the individual service, 
then Properties.

Figure 6-35    BTExplorer Settings - Security Tab

Discovery Tab

Use the Discovery tab to set and modify discovered devices.

Table 6-10    Serial Port Services Data

Item Description

Service Name Displays the name of the service.

Service Security Select the type of security from the drop-down list. Options are None, Authenticate, 
or Authenticate/Encrypt.

Local COM Port Select the COM port.

Local Baud Rate Select the communication baud rate.

Local Port Options Select the port option.

NOTE To use PIN Code, select Authenticate or Authenticate/Encrypt from the Service Security drop-down 
list on each local service.

Table 6-11    Security Data

Item Description

Use PIN Code (Incoming 
Connecting)

Select for automatic use of the PIN code entered in the PIN Code text 
box. It is recommended not to use this automatic PIN code feature. See 
Security on page 6-2 for more information.

PIN Code Enter the PIN code.

Encrypt Link On All Outgoing 
Connections

Select to enable or disable encryption on all outgoing connections to 
other Bluetooth devices.
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Figure 6-36    BTExplorer Settings - Discovery Tab

Virtual COM Port Tab

Virtual COM Port defines which COM ports BTExplorer attempts to use for virtual COM ports. Check the 
appropriate checkbox to use the port as a virtual COM port. When finished, choose Apply to enforce changes, 
or Revert to restore the original settings.

HID Tab

Use HID to select The Human Interface Device Profile programming interface that defines the protocols and 
procedures to be used to implement HID capabilities.

Provides support for devices such as mice, joysticks, keyboards.

Table 6-12    Discovery Data

Item Description

Inquiry Length Sets the amount of time the wearable terminal takes to discover 
Bluetooth devices in the area.

Name Discovery Mode Select either Automatic or Manual to automatically attempt to discover 
a Bluetooth device's name after finding the device.

Discovered Devices - Delete 
Devices

Deletes all discovered devices and link keys from memory.

Discovered Devices - Delete 
Linked Keys

Removes all pairing from remote Bluetooth devices, and makes them all 
un-trusted.

Table 6-13    Virtual COM Port Data

Item Description

COM5:Bluetooth Enable or disable COM Port 5.

COM9:Bluetooth Enable or disable COM Port 9.

COM11:Bluetooth Enable or disable COM Port 11.

COM21:Bluetooth Enable or disable COM Port 21.

COM22:Bluetooth Enable or disable COM Port 22.

COM23:Bluetooth Enable or disable COM Port 23.
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Profiles

Use Profiles to load or remove Bluetooth service profiles. If a profile is not used, it can be removed to save 
memory.

1. Tap a check box next to the profile to load (activate). The serial Port profile is always active and cannot be 
removed.

2. Tap Select All to select all profiles or tap Deselect All to deselect all profiles.

3. Tap Apply to activate the profiles and then Close to exit the application.

System Parameters

Use System Parameters to set device connection settings.

Miscellaneous Tab

Use the Miscellaneous tab to set color and types to better view active connections.

Table 6-14    HID Data

Item Description

Enable Key Repeat Enables key repeat functionality.

Delay To increase key repeat delay, drag the Delay slider to the right. To 
decrease key repeat delay, drag the Delay slider to the left.

Rate To increase key repeat speed, drag the Rate slider to the left. To 
decrease key repeat speed, drag the Rate slider to the right.

Table 6-15    HID Tab

Item Description

Page Timeout Sets the amount of time the wearable terminal searches for a device 
before moving on to the next device.

Link Supervision Timeout Sets the amount of time that the wearable terminal will wait for a device to 
come back into range after it has gone out of range. If the device does not 
come back into range by the set time, the wearable terminal drops the 
connection.

Table 6-16    Miscellaneous Tab

Item Description

Highlight Connections Select the connection type to highlight when connected. In the Wizard 
Mode, the only option is Favorites or None. In the Explorer mode the 
options are None, Tree View Only, List View Only or tree and List View.

Apply Text Style Select the text style to be applied to the connection text.

Apply Text Color Select the text color to be applied to the connection text.
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Using the Microsoft Bluetooth Stack
The following sections provide information on using the Microsoft Bluetooth stack.

Power Modes

The Bluetooth radio switches between normal and low power modes automatically. When data transfer is 
required, the radio goes into normal mode. When there is no activity, the radio goes into low power mode.

Turning the Bluetooth Radio Mode On and Off

Turn off the Bluetooth radio to save power or if entering an area with radio restrictions (e.g., an airplane). When 
the radio is off, the wearable terminal can not be seen by or connected to other Bluetooth devices. Turn on the 
Bluetooth radio to exchange information with other Bluetooth devices (within range). Communicate only with 
Bluetooth radios in close proximity.

Disabling Bluetooth

To disable Bluetooth, select Start > Settings > Control Panel > MotoBTUI and then select On icon in the top 
left corner.

 

Figure 6-37    Disable Bluetooth

Enabling Bluetooth

To enable Bluetooth, select Start > Settings > Control Panel > MotoBTUI and then select Off icon in the top 
left corner.

Figure 6-38    Enable Bluetooth

NOTE To achieve the best battery life in wearable terminals with multiple radios, turn off the radios that are not 
being used. 
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Discovering Bluetooth Device(s)

The wearable terminal can receive information from discovered devices without pairing. However, once paired, 
the wearable terminal and a paired device exchange information automatically when you turn the Bluetooth 
radio on.

To find Bluetooth devices in the area:

1. Ensure that Bluetooth is enabled on the device.

2. Ensure that the Bluetooth device to discover is in discoverable and connectable modes.

3. Ensure that the two devices are within 10 meters (32.8 feet) of one another.

4. Select Start > Programs > MotoBTUI.

Figure 6-39    MotoBTUI Window

5. If Bluetooth is off, select the Bluetooth icon to turn Bluetooth on.

6. Select the Connections tab. The wearable terminal begins searching for discoverable Bluetooth devices 
in the area. Discovered devices appear in the list.

Figure 6-40    Searching for Bluetooth Devices

7. Use the navigation key to select a Bluetooth device.

8. Press ENTER. The Services window displays.
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Figure 6-41    Services Window

9. Select Pair.

Figure 6-42    Enter PIN

10. Enter a PIN and then select OK.

11. On the Bluetooth device, enter the same PIN.

12. Enter the PIN on the other device. The device in the list become trusted (key icon).

You are prompted to enter a PIN. If the device has a specific PIN, enter it in the PIN field and tap Next. If 
the device does not have a specific passcode, enter one in the Passcode field and tap Next. The Bluetooth 
radio tries to connect with the device.

13. If you created a passcode, you will be prompted by the other device to enter the same passcode. Enter the 
created passcode to establish a paired connection. (If you entered a passcode from the device, you 
shouldn’t have to do anything on the other device.)

14. When the connection is complete, a list of matching and supported services on the device appears.

15. Select the services you want to use and tap Finish. The services on the new devices have to be selected 
or else the pairing won’t include those services, even though the devices are paired. If services are not 
selected, you will be continually re-prompted for the passcode from the device.

16. The device appears in the list on the main window.

After the passcodes have been accepted on both sides, you have a trusted (“paired”) connection.

Available Services

The wearable terminal with Microsoft Bluetooth stack offers the Serial Port service and Headset service.

NOTE Some devices might not require a PIN. This depends upon the device’s authentication.

NOTE In order to connect to the Bluetooth device, the application must create the connection to the remote 
device. Please refer to the MSDN Help for detailed information.
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Bluetooth Printing

To print to a Bluetooth printer:

1. Download and install the Windows CE Printer Drivers for the wearable terminal from the Support Central 
web site.

2. Change the following registry entries of the desired printer (using a remote registry editor):

Key: HKEY_LOCAL_MACHINE\Drivers\BuiltIn\SymPrint

• Set TldDLL to PrintTLDBluetooth.dll.

• Modify PrintPort with appropriate COM port index value. (e.g.: COM4: 19200).

3. Tap Start > Settings > Control Panel > MotoBTUI.

4. If Bluetooth is off, select the Bluetooth icon to turn Bluetooth on.

5. Select the Connections tab. The wearable terminal begins searching for discoverable Bluetooth devices 
in the area. Discovered devices appear in the list.

Figure 6-43    Searching for Bluetooth Devices

6. Use the navigation key to select a Bluetooth device.

7. Press ENTER. The Services window displays.

8. Pair and activate the desired printer from the list. See Discovering Bluetooth Device(s) on page 6-31.

9. Tap Start > Programs > Windows Explorer.

10. Open the Applications folder.

11. Open the Samples folder.

12. Launch BTVirtualCOM (Install the Samples from the Desktop if not installed).
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Figure 6-44    BTVirtualCOM Window

13. Select the desired printer from the list box.

14. In the COM Index text box, enter the COM port value entered in the registry, see step 2b.

15. Tap Create.

16. Tap Start > Programs >Samples > Printing. (Install the Samples from the Desktop if not installed).

17. Tap Settings > Printer.

18. Select the printer from the dialog box and tap OK.

19. Tap File > Print or Print without Graphics.

Headset Services

To connect to a Bluetooth headset:

1. If the wearable computer is not paired with a Bluetooth headset, see Discovering Bluetooth Device(s) on 
page 6-31.

2. Tap Start > Settings > Control Panel > MotoBTUI.

3. If Bluetooth is off, select the Bluetooth icon to turn Bluetooth on.

4. Select the Connections tab. The wearable terminal lists paired and available Bluetooth devices.

5. Use the navigation key to select the Bluetooth headset.

6. Press ENTER. The Services window displays.

7. Use the navigation key to select the Bluetooth headset.

8. Press ENTER. The wearable computer connects to the Bluetooth headset.



CHAPTER 7 APPLICATION 
DEVELOPMENT
Introduction
This chapter describes features in Windows CE 7.0 including how to package applications, and procedures for 
deploying applications onto the wearable terminal.

Software Installation on Development PC
To develop applications to run on the wearable terminal, install the following:

• Microsoft Windows XP (32-bit) or Microsoft Windows Vista (32-bit) or Microsoft Windows 7 (32-bit and 
64-bit).

• One of the following device sync components:

• Microsoft ActiveSync 4.5 or higher for Windows XP

• Microsoft® Mobile Device Center pre-installed with Windows Vista 

• Microsoft® Windows Mobile Device Center 6.1 or higher for Windows 7.

• Install one or more of the following:

• Microsoft® Visual Studio 2005 with Service Pack 1

• Microsoft® Visual Studio 2008 with Service Pack 1

• Enterprise Mobility Developer Kit (EMDK) for C

The EMDK for C is a development tool used to create native C and C++ applications for all Zebra 
devices. It includes documentation, header files (.H), and library files (.LIB) for native code application 
development that targets Zebra value-add APIs.

• Platform Software Developer Kit (Platform SDK) for WT41N0

The Platform SDK for WT41N0 is used in conjunction with the EMDK for C to create Windows CE 
applications for the wearable terminal. The Platform SDK installs a new Windows CE device type and its 
associated libraries onto the development PC.

Platform SDK

To download and install the appropriate Platform SDK:
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1. Download the appropriate Platform SDK from the Support Central web site, http://www.zebra.com/support.

a. Select WT4100. The WT4100 Product page displays.

b. On the WT4100 Product page, select the appropriate Platform SDK for WT4100 from the Software 
Downloads section. The Platform SDK page displays.

c. Save the .exe file to the development computer.

2. Run the file and follow the screen prompts to install.

EMDK for C

To download and install the EMDK for C:

1. Download the appropriate Platform SDK from the Support Central web site, http://www.zebra.com/support.

a. Select WT4100. The WT4100 Product page displays.

b. On the WT4100 Product page, select the appropriate Enterprise Mobility Developer Kit for C from the 
Software Downloads section. The Enterprise Mobility Developer Kit for C page displays.

c. Select the latest version, and save the .exe file to the development computer.

2. Locate the .exe file on the development computer, double-click the executable file and follow the install 
screen prompts.

3. Once installed, access the components of the EMDK for C from the Enterprise Mobility Developer Kit for C 
program group of the Windows Start menu. 

4. The sample applications provide examples of how to interface with the Zebra API functions. To build a 
sample application, open the Samples folder from the Windows Start menu. Open the folder for the desired 
sample and then open the project file. The project file has an extension of vcproj. Microsoft Visual Studio 
automatically launches. Select WinCE as the Active WCE Configuration. Select Win32 (WCE ARMV4) 
Debug as the active configuration.

Installing Other Development Software

Developing applications for the wearable terminal may require installing other development software, such as 
application development environments, on the development PC. Follow the installation instructions provided 
with the software.

Software Updates

Download updates to the EMDK for C from the Support Central web site at: http://www.zebra.com/support. 
Check this site periodically for important updates and new software versions.

Windows CE Flash Storage
In addition to the RAM-based storage standard on the wearable terminal, the wearable terminal is also 
equipped with a non-volatile Flash-based storage area which can store data (partitions) that can not be 
corrupted by a cold boot. This Flash area is divided into two categories: Flash File System (FFS) Partitions and 
Non-FFS Partitions.

http://www.zebra.com/support
http://www.zebra.com/support
http://www.zebra.com/support


Application Development 7 - 3
FFS Partitions

The wearable terminal includes two FFS partitions. These partitions appear to the wearable terminal as a hard 
drive that the OS file system can write files to and read files from. Data is retained even if power is removed.

The two FFS partitions appear as two separate folders in the Windows CE file system and are as follows:

• Platform: The Platform FFS partition contains Zebra-supplied programs and Dynamic Link Libraries 
(DLLs). This FFS is configured to include DLLs that control system operation. Since these drivers are 
required for basic wearable terminal operation, only experienced users should modify the content of this 
partition.

• Application: The Application FFS partition is used to store application programs needed to operate the 
wearable terminal.

Working with FFS Partitions

Because the FFS partitions appear as folders under the Windows CE file system, they can be written to and 
read like any other folder. For example, an application program can write data to a file located in the 
Application folder just as it would to the Windows folder. However, the file in the Application folder is in 
non-volatile storage and is not lost on a cold boot (e.g., when power is removed for a long period of time).

Standard tools such as ActiveSync can be used to copy files to and from the FFS partitions. They appear as 
the “Application” and “Platform” folders to the ActiveSync explorer. This is useful when installing applications 
on the wearable terminal. Applications stored in the Application folder are retained even when the wearable 
terminal is cold booted, just as the Sample Applications program is retained in memory.

There are two device drivers included in the Windows CE image to assist developers in configuring the 
wearable terminal following a cold boot: RegMerge and CopyFiles.

RegMerge.dll

RegMerge.dll is a built-in driver that allows registry edits to be made to the Windows CE registry. Regmerge.dll 
runs very early in the boot process and looks for registry files (.reg files) in certain Flash File System folders 
during a cold boot. It then merges the registry changes into the system registry located in RAM.

Since the registry is re-created on every cold boot from the default ROM image, the RegMerge driver is 
necessary to make registry modifications persistent over cold boots.

RegMerge is configured to look in the root of two specific folders for .reg files in the following order:

\Platform

\Application

Regmerge continues to look for .reg files in these folders until all folders are checked. This allows folders later 
in the list to override folders earlier in the list. This way, it is possible to override Registry changes made by the 
Platforms partitions folders. Take care when using Regmerge to make registry changes.

Making modifications to registry values for drivers loaded before RegMerge is not recommended. However, 
these values may require modification during software development. Since these early loading drivers read 
these keys before RegMerge gets a chance to change them, the wearable terminal must be cold booted. The 
warm boot does not re-initialize the registry and the early loading driver reads the new registry values.

NOTE Regmerge only merges the .reg files on cold boots. The merge process is skipped during a warm boot.
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Do not use Regmerge to modify built-in driver registry values, or merge the same registry value to two files in 
the same folder, as the results are undefined.

CopyFiles

Windows CE expects certain files to be in the Windows folder, residing in volatile storage. Windows CE 
maintains the System Registry in volatile storage. CopyFiles copies files from one folder to another on a cold 
boot. Files can be copied from a non-volatile partition (Application or Platform) to the Windows or other volatile 
partition during a cold boot. During a cold boot CopyFiles looks for files with a .CPY extension in the root of the 
Platform and Application FFS partitions (Platform first and then Application). These files are text files 
containing the source and destination for the desired files to be copied separated by “>”.

Files are copied to the Windows folder from the Flash File System using copy files (*.cpy) in the following 
order:

\Platform

\Application

Example:

\Application\ScanSamp2.exe>\Windows\ScanSamp2.exe

This line directs CopyFiles to copy the ScanSamp2.exe application from the \Application folder to the 
\Windows folder.

Non-FFS Partitions

Non-FFS partitions include additional software and data pre-loaded on the wearable terminal that can be 
upgraded. Unlike FFS Partitions, these partitions are not visible when the operating system is running. They 
also contain system information. Non-FFS partitions include the following:

• Windows CE: The complete Windows CE operating system is stored on Flash devices. If necessary, the 
entire OS image may be downloaded to the wearable terminal using files provided by Zebra. Any 
upgrades must be obtained from Zebra. This partition is mandatory for the wearable terminal.

• Splash Screen: a bitmap smaller than 16 Kb (and limited to 16 bits per pixel) is displayed as the wearable 
terminal cold boots. To download a customized screen to display, see Creating a Splash Screen on page 
7-15.

• Bootloader: This program interfaces with the host computer and allows downloading via USB cable any 
or all of the partitions listed above, as well as updated versions of Bootloader. Use caution downloading 
updated Bootloader versions; incorrect downloading of a Bootloader causes permanent damage to the 
wearable terminal. Bootloader is mandatory for the wearable terminal.

• Partition Table: Identifies where each partition is loaded in the WT41N0.

Downloading Partitions to the WT41N0

USBDownload is used to specify a hex destination file for each partition and download each file to the 
WT41N0. This download requires a program loader stored on the wearable terminal. The wearable terminal 
comes with a program loading utility, Bootloader, stored in the wearable terminal's write-protected flash.

Bootloader

Bootloader allows the user to upgrade the wearable terminal with software updates and/or feature 
enhancements.
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Partition Update vs. File Update

There are two types of updates supported by the wearable terminal: partitions and files. The file system used 
by the wearable terminal is the same as the file system used on a desktop computer. A file is a unit of data that 
can be accessed using a file name and a location in the file system. When a file is replaced, only the contents 
of the previous file are erased. The operating system must be running for a file to be updated, so the 
Bootloader cannot perform individual file updates as it is a stand-alone program that does not require the 
operating system to be running.

A typical partition is a group of files, combined into a single “partition” that represents a specific area of storage. 
Examples of partitions are the flash file systems such as Platform or Application. (Using the desktop computer 
comparison, these partitions are roughly equivalent to a C: or D: hard disk drive.) In addition to the “hard disk” 
partitions, some partitions are used for single items such as the operating system, monitor, or splash screen. 
(Again using a desktop computer comparison, these partitions are roughly the equivalent of the BIOS or 
special hidden system files.) When a partition is updated, all data that was previously in its storage region is 
erased - i.e. it is not a merge but rather a replacement operation. Typically, the operating system is not running 
when partitions are update, so Bootloader can perform partition updates.

All partition images suitable for use by Bootloader are in hex file format for transfer by USBDownloader from 
the development computer to the wearable terminal.

Upgrade Requirements

Upgrade requirements:

• The hex files to be downloaded (on development computer)

• A connection from the host computer and the wearable terminal

• USBDownload (on development computer) to download the files.

Once these requirements are satisfied, the wearable terminal can be upgraded by invoking Bootloader and 
navigating the menus. See Bootloader on page 7-9 for procedures on downloading a hex file to the wearable 
terminal.

Deployment
This section provides information about installing software and files on the wearable terminal.

Software deployment can be performed by:

• Copying files from a host computer

• Updating images.

Copying Files from a Host Computer

Copy files to the wearable terminal using ActiveSync or by placing the wearable terminal into mass storage 
mode.

ActiveSync

To copy files from a host computer to the wearable terminal:

1. Ensure that ActiveSync is installed on the host computer and that a partnership was created. For more 
information see, Chapter 3, Synchronization.
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2. Connect the wearable terminal to the host computer using a Single-slot USB cradle or an appropriate 
cable. See Chapter 2, Accessories for connection information.

3. On the host computer, select Start > Programs > ActiveSync.

Figure 7-1    ActiveSync Connected Window

4. Select Explore.

Figure 7-2    ActiveSync Explorer

5. Double-click the folder to expand the folder contents.
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Figure 7-3    Application Folder Contents

6. Use Explorer to locate the host computer directory that contains the file to download. Tap that directory in 
the left pane to display its contents in the right pane.

7. Drag the desired file(s) from the host computer to the desired mobile device folder.

Mass Storage

To install an application or copy files to the wearable terminal using a USB connection:

1. On the wearable terminal, select Start > Settings > Control Panel > USBConfig.

Figure 7-4    USBConfig Window

2. On the USB Port Mode tab, select USB Client Mode.

3. On the USB Client Mode tab, select Mass Storage.

4. In the drop-down list, select Platform or Application.

5. Select OK.

6. Connect the wearable terminal to a host computer using either a Single-slot USB cradle or a USB 
ActiveSync/Charge cable.

7. On the host computer, open Windows Explorer. The wearable terminal appears as a hard disk drive in 
Windows Explorer.

8. On the host computer, open another Windows Explorer window and locate the files to copy to the 
wearable terminal.
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9. Drag the files from the new window to the wearable terminal folder window.

10. When complete, disconnect the wearable terminal from the host computer.

Updating Images

The wearable terminal contains tools that update all operating system components. All updates are distributed 
as packages and/or hex images. Update packages can contain either partial or complete updates for the 
operating system. Zebra distributes the update packages on the Support Central Web Site, 
http://www.zebra.com/support.

Update an operating system component using one of the following:

• OS Update

• BootLoader.

• MSP. See Mobility Services Platform on page 7-15 for information.

OSUpdate Loader

Operating system component can be downloaded to the wearable terminal using the Temp folder.

Using the Temp Folder

To initiate an update using the wearable terminal Temp folder:

1. Go to the Support Central web site, http://www.zebra.com/support and download the appropriate update 
package.

2. Connect the wearable terminal to a host computer using the Single Slot USB Cradle or USB 
ActiveSync/Charge Cable. See Chapter 2, Accessories.

3. Select Start > Settings > Control Panel.

4. Select System icon.

5. Select Memory tab.

Figure 7-5    System Properties - Memory Tab

6. Move the slider to the center position.

7. Select OK.

8. Using ActiveSync, copy the update package to the \Temp folder on the wearable terminal.

9. On the wearable terminal, use Windows Explorer and navigate to the \Temp folder.

10. Open the OSUpdate folder.

http://www.zebra.com/support
http://www.motorolasolutions.com/support
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11. Select the file: 4100c70Aen_TEMP.lnk.

12. When the Update Loader application finds the appropriate file, it loads the package onto the wearable 
terminal. A progress bar displays until the update completes.

13. When complete, the wearable terminal re-boots.

Bootloader

Use Bootloader to download hex files to the wearable terminal from a host computer via USB.

WT41N0

Use Bootloader to download customized flash file system partitions to the WT41N0 and load hex files to the 
flash memory of the WT41N0.

To load the hex files on to the WT41N0 using USB:

1. Download the USBDownload application from the Support Central web site. Follow the installation 
instructions with the application.

2. Connect the WT41N0 to a host computer using the Single-slot USB Cradle or USB ActiveSync/Charge 
Cable.

3. On the host computer, launch the USBDownload application.

Figure 7-6    USB Download Window

4. Simultaneously press the Power button and the 1 and 9 keys.

5. Immediately, as soon as the device starts to boot, press and hold the P2 key. The Bootloader screen 
appears.

Figure 7-7    Bootloader Menu

Select required operation

Download from SD card
Download from USB
Exit

Bootloader 1.02.0000

2015 Symbol Technologies, Inc.
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1. Use the up and down scroll buttons to select Download from USB, then press ENTER.

2. The Bootloader displays the following:

Figure 7-8    Waiting for Input

1. On the host computer, locate the hex files to download.

Figure 7-9    Select Source File Window

2. Select the hex files and the click Open.

CAUTION To ensure a successful download, do not remove power from the WT41N0 while in Bootloader.

Waiting for input. . .

Bootloader 1.02.0000

NOTE One hex file or multiple hex files can be selected. To select multiple files, press the Ctrl key while selecting 
files.

If selecting multiple files to download, USBDownload reads the header of the file and identifies the file 
type. If the Partition table file is among the files selected, then USBDownload downloads that file first. 
Similarly, USBDownload downloads the CPLD file last.
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Figure 7-10    Select Hex File(s)

3. Click the LOAD button. The hex file(s) is downloaded to the device.

Figure 7-11    Download Complete Screen

4. On completion, press ENTER to return to the Bootloader main screen to select the next file to download.

5. To exit Bootloader, select Exit from the Bootloader main screen and press ENTER.

Voice Only WT41N0

Use Bootloader to download customized flash file system partitions to the Voice Only WT41N0 and load hex 
files to the flash memory of the WT41N0.

To load the hex files on to the Voice Only WT41N0 using USB:

1. Download the USBDownload application from the Support Central web site. Follow the installation 
instructions with the application.

2. Connect the Voice Only WT41N0 to a host computer using the Single-slot USB Cradle or USB 
ActiveSync/Charge Cable.

3. On the host computer, launch the USBDownload application.

Splash screen
#### (20) 100%
Download complete
in - 0.042 seconds
(1854142 bytes/second)

Hit Enter to Acknowledge

Bootloader 1.02.0000

2014 Symbol Technologies, Inc.
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Figure 7-12    USB Download Window

4. Simultaneously press the Power button and the P1 and P2 keys.

5. Immediately, press and hold the P2 key. The three LEDs on the front of the Voice Only WT41N0 light 
indicating that it is in Download mode.

 

6. On the host computer, locate the hex files to download.

Figure 7-13    Select Source File Window

7. Select the hex files and the click Open.

2015 Symbol Technologies, Inc.

CAUTION To ensure a successful download, do not remove power from the Voice Only WT41N0 while in 
Bootloader.

NOTE One hex file or multiple hex files can be selected. To select multiple files, press the Ctrl key while selecting 
files.

If selecting multiple files to download, USBDownload reads the header of the file and identifies the file 
type. If the Partition table file is among the files selected, then USBDownload downloads that file first. 
Similarly, USBDownload downloads the CPLD file last.
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Figure 7-14    Select Hex File(s)

8. Click the LOAD button. The hex file(s) is downloaded to the device. The LEDs light from left to right 
indicating the progress of the file transfer. The Left LED lights at 33%, THe left and center LEDs light at 
66% and all three LEDs light at 100%.

9. After all the files have been loaded onto the Voice Only WT41N0, simultaneously press the Power button, 
P1 and P2 keys to re-boot the device.

Bootloader Error Detection

While receiving data, Bootloader performs many checks on the data to ensure that the data is received 
correctly. If an error is detected, Bootloader immediately aborts the download, and reports the error on an error 
screen.

This error message screen displays until a key is pressed. Once the screen is acknowledged, Bootloader 
returns to the main menu to wait for a new selection.

To find the probable cause of the error, use the error number and/or the error text displayed on the screen to 
look up the error in Table 7-1.

2015 Symbol Technologies, Inc.

NOTE If an invalid image is selected, the LEDs blink three times.

Table 7-1    Bootloader Errors

Error Text Error 
Number Probable Cause

Unknown error -1 A general error occurred. Retry the download. If the failure persists, it is 
most likely due to a hardware failure; the wearable terminal requires 
servicing.

Cancelled by user -2 The user cancelled the download.

Can't open the 
source

-7 An error occurred opening the source device (either USB or SDMMC). 
Check source device connectivity and retry.

Can't open the 
destination

-8 An error occurred opening the destination device (either NAND, RAM, 
Power Micro, or CPLD). Retry the download. If the failure persists, it is 
most likely due to a hardware failure; the wearable terminal requires 
servicing.

Can't read from the 
source device

-9 The source device (either USB or SDMMC) could not be read from. 
Check source device connectivity and retry.
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Can't write to the 
destination device

-10 The destination device (either NAND, RAM, Power Micro, IST, 
Keyboard Controller or CPLD) could not be written to. Retry the 
download. If the failure persists, it is most likely due to a hardware 
failure; the wearable terminal requires servicing.

Transmission 
checksum error

-11 An error occurred during transmission from the source device (either 
USB or SDMMC) and the checksum check failed. Check source device 
connectivity and retry.

Readback checksum 
error

-12 A checksum, generated from reading back data that was written to the 
destination device, was incorrect. An error during transmission or a write 
error to the destination device could cause this.

There is no more 
heap space available

-14 There is no more heap space available for the download procedure. 
Restart Bootloader and retry the download. If the failure persists, 
contact service with details of what is being downloaded.

Invalid data in verify 
file

-19 The file contains invalid data. Check that the file is suitable for 
downloading on this terminal.

Insufficient memory 
for buffering data

-20 There is no more heap space available for the download procedure. 
Restart Bootloader and retry the download. If the failure persists, 
contact service with details of what is being downloaded.

Insufficient data 
available to complete 
record

-21 A HEX file download was attempted but the HEX file is invalid. Ensure 
the file is in proper HEX file format.

Invalid HEX file -23 A HEX file download was attempted but the HEX file is invalid. Ensure 
the file is in proper HEX file format.

Unrecognized or 
unsupported HEX 
record

-24 The HEX file being downloaded contains an invalid or unrecognized 
HEX record. Ensure the file is in proper HEX file format.

Invalid data in HEX 
file

-25 The HEX file being downloaded contains invalid data. Ensure the file is 
in proper HEX file format with valid HEX data.

Exceeded max size -26 The download file is too large to fit into the space allocated for it. Either 
make the file smaller or increase the space allocated for it by altering 
the partition table.

Partition is not valid 
on this device

-27 The downloaded file specifies a partition entry that does not exist on the 
device. Only download files that are valid for this device, or change the 
partition table so that the new file is valid on the device.

Wrong destination 
code

-28 A specific partition was chosen from the Bootloader main menu but the 
file selected for download was for another partition. Ensure that the 
partition selected from the Bootloader main menu matches the file 
selected for download.

Non-contiguous 
record found

-30 A HEX file download was attempted but the HEX file is invalid. Ensure 
the file is in proper HEX file format.

Table 7-1    Bootloader Errors (Continued)

Error Text Error 
Number Probable Cause
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Mobility Services Platform

The MSP Client Software is a set of software components that come pre-installed on the wearable terminal. 
The MSP Client software consists of the following components:

The RD Client provides support for MSP Staging functionality, provides support for the MSP Legacy Staging 
process, and provides support for backward-compatible legacy MSP 2.x Legacy Staging functionality.

The MSP Agent provides MSP Provisioning functionality and Control functionality when used with MSP 3.2 
Control Edition.

Refer to the Mobility Services Platform 3.2 User’s Guide, p/n 72E-100158-06, for instructions for using the 
Rapid Deployment and MSP Agent clients.

Creating a Splash Screen
A custom splash screen can be created and loaded onto the wearable terminal. To create a custom splash 
screen:

1. Create a .bmp file using a graphic program with the following specifications:

• Size: 320 (W) x 216 (H).

• Colors: 256.

2. Modify the bitmap file and save.

To load the splash screen:

1. Convert the bmp file into a hex file using the OSUpdate Package Builder that is part of MSP.

2. Copy the hex file to the wearable terminal using BootLoader. See Bootloader on page 7-9.

Timed Out - No data -31 Bootloader was waiting for data from the source device but timed out 
before receiving any. Check the source device connectivity and retry.

Invalid file format -33 The file format is invalid. Only HEX files are supported by Bootloader.

Partition Table not 
Valid

-34 The size of flash memory is different than that described in the partition 
table. Retry the download with the correct partition table file.

Invalid data in file -35 The .bin or .sig file being downloaded contains invalid data. Ensure the 
file is in proper file format.

File cannot be loaded 
to this unit

-38 The file contains valid data that indicates it cannot be loaded onto the 
device.

File validation failed -40 The file has either been signed incorrectly, or contains data that 
indicates that it cannot be loaded onto the terminal.

Table 7-1    Bootloader Errors (Continued)

Error Text Error 
Number Probable Cause
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CHAPTER 8 SPECIAL CONSIDERATIONS
Introduction
This chapter provides special considerations when developing applications for the WT41N0.

Touch Panel User Interface Considerations
When developing applications for a touch panel interface, touch panel activation only by the ball of the finger 
means there are limitations to what the user interface of an application can expect of a worker

• User interface elements such as buttons, that require activation by a bare finger tip on the touch screen 
should not be smaller than 10 mm x 10 mm (as opposed to 5 mm x 5 mm if a stylus were an option).

• Do not put user interface elements close to the edge of the display. They’re hard to activate and they 
might not be fully covered by the protective overlay. Keep the touch points at least 2 mm in from the 
edge.

Tips for Improving Battery Life
To improve the life of the battery:

• Set the display backlight to turn off quickly and reduce the display brightness.

• Set the keypad backlight to turn off quickly.

• Set the wearable computer to suspend when not in use and maximum CPU performance.

• Set the WLAN radio to save maximum power.

After making these settings, they can be saved in Registry files to make them cold-boot persistent.

Display Backlight

NOTE Changing the Backlight setting on the Voice Only WT41N0 will change the brightness of the Application 
Controlled LED. Refer to the EMDK Help file WT41N0-VOW Programming page for more information.
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To change the display backlight settings in order to conserve battery power:

1. Select Start > Settings > Control Panel.

2. Select Backlight icon.

3. Select Battery Power tab.

4. Ensure that the Disable backlight if not used for checkbox is checked.

5. In the drop-down list, select the amount of time after which the display will turn off. Set to 1 minute or a 
lower value that the user is comfortable with.

To set the brightness level of the display:

1. Select Brightness tab.

2. Move the slider to 2 to conserve power.

3. Select OK.

Keypad Light

To set the amount of time that the keypad light stays on:

1. Select Start > Settings > Control Panel.

2. Select Keylight icon.

3. Select Battery Power tab.

4. Ensure that the Disable keylight if not used for checkbox is checked.

5. In the drop-down list, select the amount of time after which the keypad light will turn off. Set to 1 minute or 
a lower value that the user is comfortable with.

To disable the key light from coming on:

1. Select the Advanced tab.

2. Ensure that the Disable keylight checkbox is checked.

Tap OK.

Power

To set the wearable computer to turn off after a short period of non-use:

1. Select Start > Settings > Control Panel.

2. Select Power icon.

3. Select Advanced tab.

4. Ensure that the Turn off device if not used for checkbox is checked 

5. In the drop-down list, select the amount of time after which the device will turn off. The default setting is 3. 
If desired, lower this value to 1 to conserve power.

NOTE Changing the Keypad Backlight setting on the Voice Only WT41N0 will change the brightness of the 
WLAN Status LED. Refer to the EMDK Help file WT41N0-VOW Programming page for more information.
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To set the CPU to maximum performance:

1. Select CPU Power tab.

2. Ensure that the Max Power Save radio button is selected. This selection maximizes battery life.

3. Select Apply.

4. Select OK.

Wireless LAN

To set the WLAN radio to maximum performance:

1. Select the wireless icon in the bottom lower right corner.

2. Select Manage Profiles.

3. Select the wireless profile.

4. Press ENTER.

5. Select Edit.

6. Continuously select Next until the Battery Usage Mode window appears.

7. Ensure the MAX Power Save radio button is selected.

Voice Only WT41N0 LED Considerations
• Application developers for the Voice Only WT41N0 should not program all LEDs to be turned on at the 

same time, as this sequence is reserved for IPL mode.

• Consider device battery life when programming LED blinking. Refer to the EMDK Help file 
WT41N0-VOW Programming page for more information.

RS5000 Low Charge Considerations
The first scanner detection attempt may fail if the scanner has a very low charge because the built-in power 
buffer must charge before the imager can turn on. Ensure the application retries scanner detection to allow 
more time for the scanner to charge the power buffer.

The RS5000 Bluetooth scanner is enabled by default. To disable the Bluetooth scanner to speed the RS5000 
start up time, refer to the WT41N0 User Guide Datawedge chapter.
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CHAPTER 9 MAINTENANCE & 
TROUBLESHOOTING
Introduction
This chapter includes instructions on cleaning and storing the wearable terminal, and provides troubleshooting 
solutions for potential problems during wearable terminal operating.

Maintaining the Wearable Terminal
For trouble-free service, observe the following tips when using the wearable computer:

• Do not scratch the touch screen of the wearable computer. When activating with the wearable computer 
touch screen, use finger tips. Never use a pen or pencil or other sharp object on the surface of the 
screen.

Zebra requires using a screen protector on the touch screen versions, p/n KT-114032-01R or 
KT-114032-02R.

• A screen protector is applied to the wearable computer touch screen. Zebra requires using this to 
minimize wear and tear. Screen protectors enhance the usability and durability of touch screen displays. 
Benefits include:

• Protection from scratches and gouges

• Durable touch surface with tactile feel

• Abrasion and chemical resistance

• Keeping the device’s screen looking new

• Quick and easy installation.

• Protect the wearable computer with a touch screen from temperature extremes.

• Do not store or use the wearable computer with a touch screen in any location that is extremely dusty, 
damp, or wet.

• Use a soft lens cloth to clean the wearable computer display/touch screen.

• Periodically replace the rechargeable Li-ion battery to ensure maximum battery life and product 
performance. Battery life depends on individual usage patterns.

• The screen of the wearable computer contains glass. Take care not to drop the wearable computer or 
subject it to strong impact.
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t 
• Regularly replace all Velcro® straps on the wrist mount and wearable scanners, to ensure adequate 
adhesion of the Velcro.

• On touch screen versions, periodically replace the screen protector, especially if it is scratched.

Wrist Mount Cleaning Instructions

It may be necessary to wash the wrist mount straps and replaceable pad when they become soiled.

Remove the straps and pad from the wrist mount. Hand wash in cold water with a mild detergent (such as 
Woolite®). Do not use bleach. Air dry. Do not use a dryer.

Figure 9-1    Wrist Mount Soft Goods

Arm Sleeve Cleaning Instructions

It may be necessary to wash the arm sleeve when it become soiled.

Hand wash in cold water with a mild detergent (such as Woolite®). Do not use bleach. Air dry. Do not use a 
dryer.

Removing the Screen Protector

A screen protector is applied to the wearable terminal with touch screen. Zebra mandates using this to 
minimize wear and tear. Screen protectors enhance the usability and durability of touch screen displays.

To remove the screen protector, lift the corner using a thin plastic card, such as a credit card, then carefully lift 
it off the display.

Replaceable Pad

Strap

NOTE Not using a screen protector on a touch panel device can affect warranty coverage. To purchase replacemen
protectors, contact your local account manager or Zebra Technologies Corporation. These include screen 
protector installation instructions. Part number: KT-67525-01R or KT-67525-02R Screen Protector 3/pk.
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Figure 9-2    Removing the Screen Protector

Battery Safety Guidelines
• The area in which the units are charged should be clear of debris and combustible materials or 

chemicals. Particular care should be taken where the device is charged in a non commercial 
environment.

• Improper battery use may result in a fire, explosion, or other hazard.

• To charge the mobile device battery, the battery and charger temperatures must be between 0 ºC and 
+40 ºC (+32 ºF and +104 ºF).

• Do not use incompatible batteries and chargers. Use of an incompatible battery or charger may present a 
risk of fire, explosion, leakage, or other hazard. If you have any questions about the compatibility of a 
battery or a charger, contact Zebra support.

• Do not disassemble or open, crush, bend or deform, puncture, or shred.

• Severe impact from dropping any battery-operated device on a hard surface could cause the battery to 
overheat.

• Do not short circuit a battery or allow metallic or conductive objects to contact the battery terminals.

• Do not modify or remanufacture, attempt to insert foreign objects into the battery, immerse or expose to 
water or other liquids, or expose to fire, explosion, or other hazard.

• Do not leave or store the equipment in or near areas that might get very hot, such as in a parked vehicle 
or near a radiator or other heat source. Do not place battery into a microwave oven or dryer.

• Battery usage by children should be supervised.

• Please follow local regulations to promptly dispose of used re-chargeable batteries.

• Do not dispose of batteries in fire.

Lift Screen
Protector

Corner

CAUTION Do not use a sharp object to remove the protector. Doing so can damage the touch screen.
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• Seek medical advice immediately if a battery has been swallowed.

• In the event of a battery leak, do not allow the liquid to come in contact with the skin or eyes. If contact 
has been made, wash the affected area with large amounts of water and seek medical advice.

• If you suspect damage to your equipment or battery, contact Zebra support to arrange for inspection.

Cleaning

Materials Required

• Alcohol wipes

• Soft lens cloth

• Cotton tipped applicators

• Isopropyl alcohol

• Can of compressed air with a tube.

Cleaning the Wearable Terminal

Housing

Using the alcohol wipes, wipe the housing including keys and in-between keys.

Display

The display can be wiped down with the alcohol wipes, but care should be taken not to allow any pooling of 
liquid around the edges of the display. Immediately dry the display with a soft, non-abrasive cloth to prevent 
streaking. For WT41N0 with touch panel, only use a soft lens cloth to clean the touch panel overlay surface.

Connectors

Clean all three connectors, two interface connectors on the sides of the wearable terminal and the cradle 
connector on the back.

1. Remove the main battery from mobile computer. See Installing the Main Battery on page 1-3.

2. Remove connector rubber plugs, if required.

3. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.

WARNING! Avoid exposing this product to contact with hot oil or other flammable liquids. If such 
exposure occurs, unplug the device and clean the product immediately in accordance with 
these guidelines.

CAUTION Always wear eye protection.

Read warning label on compressed air and alcohol product before using.

If you have to use any other solution for medical reasons please contact Zebra for more information.



Maintenance & Troubleshooting 9 - 5
4. Rub the cotton portion of the cotton tipped applicator back-and-forth across each connector. Do not leave 
any cotton residue on the connector.

5. Repeat at least three times.

6. Use the cotton tipped applicator dipped in alcohol to remove any grease and dirt near the connector area.

7. Use a dry cotton tipped applicator and repeat steps 4 through 7.

8. Spray compressed air on the connector areas by pointing the tube/nozzle about ½ inch away from the 
surface.

9. Inspect the area for any grease or dirt, repeat if required.

10. Replace connector rubber plugs, if required.

Cleaning the RS309, RS409, RS419, RS507 and RS5000

Housing

Using the alcohol wipes, wipe the housing including keys and in-between keys.

Scanner Exit Window

Wipe the scanner exit window periodically with a lens cloth or other material suitable for cleaning optical 
material such as eyeglasses.

Connectors

1. Disconnect the scanner from mobile computer.

2. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.

3. Rub the cotton portion of the cotton tipped applicator back-and-forth across the connector pins. Do not 
leave any cotton residue on the connector.

4. Repeat at least three times.

5. Use the cotton tipped applicator dipped in alcohol to remove any grease and dirt near the connector area.

Use a dry cotton tipped applicator and repeat steps 3 through 5.

6. Spray compressed air on the connector area by pointing the tube/nozzle about ½ inch away from the 
surface. 

7. Inspect the area for any grease or dirt, repeat if required.

Cleaning Cradle Connectors

To clean the connectors on a cradle:

1. Remove the DC power cable from the cradle.

CAUTION Do not point nozzle at yourself and others, ensure the nozzle or tube is away from your face.

CAUTION Do not point nozzle at yourself and others, ensure the nozzle or tube is away from your face.
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2. Dip the cotton portion of the cotton tipped applicator in isopropyl alcohol.

3. Rub the cotton portion of the cotton tipped applicator along the pins of the connector. Slowly move the 
applicator back-and-forth from one side of the connector to the other. Do not let any cotton residue on the 
connector.

4. All sides of the connector should also be rubbed with the cotton tipped applicator.

5. Spray compressed air in the connector area by pointing the tube/nozzle about ½ inch away from the 
surface. 

6. Ensure that there is no lint left by the cotton tipped applicator, remove lint if found.

7. If grease and other dirt can be found on other areas of the cradle, use lint free cloth and alcohol to remove.

8. Allow at least 10 to 30 minutes (depending on ambient temperature and humidity) for the alcohol to air dry 
before applying power to cradle.

If the temperature is low and humidity is high, longer drying time is required. Warm temperature and dry 
humidity requires less drying time.

Cleaning Frequency

The cleaning frequency is up to the customer’s discretion due to the varied environments in which the mobile 
devices are used. They may be cleaned as frequently as required. However when used in dirty environments it 
may be advisable to periodically clean the ring scanners’ exit windows to ensure optimum scanning 
performance.

Troubleshooting

Wearable Terminal

CAUTION Do not point nozzle at yourself and others, ensure the nozzle or tube is away from your 
face.

Table 9-1    Troubleshooting the Wearable Terminal

Problem Cause Solution

Wearable terminal does 
not turn on.

Lithium-ion battery 
not charged.

Charge or replace the lithium-ion battery in the wearable 
terminal.

Lithium-ion battery 
not installed properly.

Ensure battery is installed properly. See Installing and 
Removing the Main Battery on page 1-3.

System crash. Perform a warm boot. If the wearable terminal still does not 
turn on, perform a cold boot. See Resetting the Wearable 
Terminal on page 1-8.
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Rechargeable 
lithium-ion battery did 
not charge.

Battery failed. Replace battery. If the wearable terminal still does not 
operate, try a warm boot, then a cold boot. See Resetting 
the Wearable Terminal on page 1-8.

Wearable terminal 
removed from cradle 
while battery was 
charging. 

Insert wearable terminal in cradle and begin charging.

Ambient temperature 
of the cradle is too 
warm or too cold.

Move the cradle to an area where the ambient temperature 
is between 0 °C and 40 °C (32 °F and 104 °F).

Cannot see characters 
on display (not 
applicable to voice only 
configuration).

Wearable terminal 
not powered on.

Press the Power button.

Display on touch panel 
version is hard to read 
(not applicable to voice 
only configuration).

Screen protector may 
be scratched or worn.

Replace screen protector.

During data 
communication, no data 
was transmitted, or 
transmitted data was 
incomplete.

Wearable terminal 
removed from cradle 
or unplugged from 
host computer during 
communication.

Replace the wearable terminal in the cradle, or reattach the 
Synchronization cable and re-transmit.

Incorrect cable 
configuration.

See the System Administrator.

Communication 
software was 
incorrectly installed or 
configured.

Perform setup. See Chapter 2, Accessories for details.

Ensure that Microsoft ActiveSync 4.1 or greater is installed 
on the host computer.

No sound is audible. Volume setting is low 
or turned off.

Adjust volume. Change volume settings by selecting Start > 
Settings > Control Panel > Volume & Sounds icon > Volume 
tab. Move the slider to change the volume level or use 
volume control on voice application.

Table 9-1    Troubleshooting the Wearable Terminal (Continued)

Problem Cause Solution
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Wearable terminal turns 
itself off.

Wearable terminal is 
inactive.

The wearable terminal turns off after a period of inactivity. If 
the wearable terminal is running on battery power, this 
period can be set to 30 sec., 1, 2, 3, 4, 5 or 6 minutes. If the 
wearable terminal is running on external power, this period 
can be set to 1, 2, 3, 5, 10, 15 and 30 minutes.

Check the power settings by selecting Start > Settings > 
Control Panel > Power icon > Advanced tab.

Change the setting if a longer delay is required before the 
automatic shutoff feature activates.

Voice Only WT41N0 
was set to suspend.

Return Voice Only WT41N0 suspend setting to factory 
default (disabled).

Battery is depleted. Replace or recharge the battery.

Battery is not inserted 
properly.

Insert the battery properly (see Installing and Removing the 
Main Battery on page 1-3).

The wearable 
computer’s battery is 
low and it powers 
down to protect 
memory content.

Replace or recharge the battery.

A message appears 
stating that the 
wearable terminal 
memory is full. (not 
applicable to voice only 
configuration).

Too many files stored 
on the wearable 
terminal.

Delete unused memos and records. You can save these 
records on the host computer.

Too many 
applications installed 
on the wearable 
terminal.

If you have installed additional applications on the wearable 
terminal, remove them to recover memory.

Select Start > Settings > Control Panel > Remove Programs 
icon.

Select the unused program and select Remove.

Table 9-1    Troubleshooting the Wearable Terminal (Continued)

Problem Cause Solution
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The wearable terminal 
does not accept scan 
input.

Scanning application 
is not loaded.

Verify that the unit is loaded with a scanning application. 
See the System Administrator.

Unreadable bar code. Ensure the symbol is not defaced.

Distance between 
exit window and bar 
code is incorrect.

Ensure wearable terminal is within proper scanning range.

Wearable terminal is 
not programmed for 
the bar code.

Ensure the wearable terminal is programmed to accept the 
type of bar code being scanned. 

Wearable terminal is 
not programmed to 
generate a beep.

If a beep on a good decode is expected and a beep is not 
heard, check that the application is set to generate a beep 
on good decode.

Battery is low. If the scanner stops emitting a laser beam when the trigger 
is pressed, check the battery level. When the battery is low, 
the scanner shuts off before the wearable terminal low 
battery condition notification. 
Note: If the scanner is still not reading symbols, contact the 
distributor or Zebra.

Wearable terminal goes 
into IPL mode after cold 
boot.

Headset adapter 
without a headset is 
connected to the 
wearable terminal 
during a cold boot.

Disconnect the headset adapter prior to performing a cold 
boot.

Scanner trigger is 
held down during a 
cold boot.

Do not press trigger during a cold boot.

P1 or P2 key is held 
down during a cold 
boot.

Do not press the P1 or P2 key during a cold boot.

If all three LEDs are lit 
solid.

Voice Only WT41N0 
is in IPL mode.

Perform cold boot. See Resetting the Wearable Terminal 
on page 1-8.

WLAN connection is 
lost when the wearable 
terminal is connected to 
a host computer using 
ActiveSync.

Microsoft security 
feature prevents 
connection to two 
separate networks.

Disconnect from the WLAN network prior to connecting to a 
host computer using ActiveSync.

Table 9-1    Troubleshooting the Wearable Terminal (Continued)

Problem Cause Solution
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Four Slot Spare Battery Charger

Four Slot Ethernet Cradle

Table 9-2    Troubleshooting The Four Slot Spare Battery Charger

Symptom Possible Cause Solution

Batteries not 
charging.

Battery was removed 
from the charger or 
charger was unplugged 
from AC power too 
soon.

Re-insert the battery in the charger or re-connect the charger’s 
power supply.

Battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.

Battery contacts not 
connected to charger.

Verify that the battery is seated in the battery well correctly with the 
contacts facing down.

Ambient temperature of 
the charger is too warm 
or too cold.

Move the charger to an area where the ambient temperature is 
between 0 °C and 40 °C.

Table 9-3    Troubleshooting the Four Slot Ethernet Cradle

Problem Cause Solution

Wearable terminal amber 
Charge Status LED does not 
light when wearable terminal 
inserted.

Cradle is not receiving power. Ensure the power cable is connected 
securely to both the cradle and to AC power.

Wearable terminal is not 
correctly seated.

Remove and re-insert the wearable terminal 
into the cradle, ensuring it is correctly 
seated. 

Wearable terminal battery is 
not charging.

Wearable terminal was 
removed from cradle or cradle 
was unplugged from AC power 
too soon.

Ensure cradle is receiving power. Ensure the 
wearable terminal is seated correctly. 

Battery is faulty. Verify that other batteries charge properly. If 
so, replace the faulty battery.

The wearable terminal is not 
fully seated in the cradle.

Remove and re-insert the wearable terminal 
into the cradle, ensuring it is correctly 
seated. 

Ambient temperature of the 
cradle is too warm or too cold.

Move the cradle to an area where the 
ambient temperature is between 0 °C and 
40 °C (32 °F and 104 °F).
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Single Slot USB Cradle

During data communication, 
no data was transmitted, or 
transmitted data was 
incomplete.

Wearable terminal removed 
from cradle during 
communication.

Replace wearable terminal in cradle and 
retransmit.

Incorrect cable configuration. See the system administrator.

Ethernet connection error. Link 
LED is not lit (see Four Slot 
Ethernet Cradle on page 2-6). 

See the system administrator. Probable 
Ethernet connection error.

Table 9-3    Troubleshooting the Four Slot Ethernet Cradle (Continued)

Problem Cause Solution

Table 9-4    Troubleshooting the Single Slot USB Cradle

Symptom Possible Cause Action

LEDs do not 
light when 
wearable 
terminal or 
spare battery is 
inserted.

Cradle is not receiving 
power.

Ensure the power cable is connected securely to both the cradle 
and to AC power.

Wearable terminal is not 
seated firmly in the 
cradle.

Remove and re-insert the wearable terminal into the cradle, 
ensuring it is firmly seated. 

Spare battery is not 
seated firmly in the 
cradle.

Remove and re-insert the spare battery into the charging slot, 
ensuring it is firmly seated. 

Wearable 
terminal battery 
is not charging.

Wearable terminal was 
removed from cradle or 
cradle was unplugged 
from AC power too 
soon.

Ensure cradle is receiving power. Ensure wearable terminal is 
seated correctly. Confirm main battery is charging.

View battery status by selecting Start > Settings > Control Panel 
> Power icon.

Battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.

The wearable terminal is 
not fully seated in the 
cradle.

Remove and re-insert the wearable terminal into the cradle, 
ensuring it is firmly seated. 

Ambient temperature of 
the cradle is too warm or 
too cold.

Move the cradle to an area where the ambient temperature is 
between 0 °C and 40 °C (32 °F and 104 °F).

Spare battery is 
not charging.

Battery not fully seated 
in charging slot. 

Remove and re-insert the spare battery into the cradle, ensuring 
it is firmly seated. 

Battery inserted 
incorrectly. 

Ensure the contacts are facing down and toward the back of the 
cradle. 

Battery is faulty. Verify that other batteries charge properly. If so, replace the faulty 
battery.
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During data 
communications
, no data was 
transmitted, or 
transmitted data 
was incomplete.

Wearable terminal 
removed from cradle 
during communications.

Replace wearable terminal in cradle and retransmit.

Incorrect cable 
configuration.

See the System Administrator.

Communications 
software is not installed 
or configured properly.

Perform setup as described in Chapter 2, Accessories.

Ensure that Microsoft ActiveSync 4.1 or greater is installed on the 
host computer.

Cannot 
ActiveSync with 
Host Computer

Wrong USB cable used. Ensure that the cable has a USB A connector on one end and a 
USB mini B connector on the other end.

Host computer not 
configured properly.

Ensure that ActiveSync on the host computer is set to allow USB 
connections.

The wearable computer 
is not fully seated in the 
cradle.

Remove and re-insert the wearable computer into the cradle, 
ensuring it is firmly seated. 

Table 9-4    Troubleshooting the Single Slot USB Cradle (Continued)

Symptom Possible Cause Action



Appendix A  Technical Specifications
Technical Specifications
The following tables summarize the wearable terminal’s intended operating environment and general technical 
hardware specifications.

Wearable Terminal

The following table summarizes the wearable terminal’s intended operating environment.

Table A-1    Technical Specifications

Item Description

Physical and Environmental Characteristics

Dimensions With Standard Battery:

14.2 cm L x 9.3 cm H x 2.6 cm H

(5.7 inches L x 3.7 inches W x 1.0 inch H)

With Extended Battery:

14.2 cm L x 10.7 cm H x 2.6 cm H

(5.7 inches L x 4.2 inches W x 1.0 inch H)

Weight (including battery) With Standard Battery: 320 g (11.3 oz.)

With Extended Battery: 369 g (13.0 oz.)

Keyboard WT41N0: Alphanumeric Keypad

Voice Only WT41N0: Three programmable function keys.

Display WT41N0: Color 2.8 inch QVGA non-touch or touch screens

Voice Only WT41N0: None

Main Battery Removable, rechargeable 3.7 VDC Lithium Ion battery.

Standard capacity: 2330 mAh (minimum)

Extended capacity: 4600 mAh (minimum)

Backup Battery NiMH battery (rechargeable) 15 mAh 2.4 VDC (not user accessible)

Performance Characteristics



A - 2 WT41N0 Integrator Guide
CPU OMAP4 processor at 1 GHz

Operating System Microsoft Windows Embedded CE 7.0 Compact

Memory 2 GB Flash/512 MB RAM

Data Capture Options RS309 scanner

RS409 scanner

RS419 scanner

RS507 Hands-free Imager

RS5000 Hands-free Imager

User Environment

Operating Temperature -4 °F to 122°F (-20 °C to 50 °C)

Storage Temperature -40 °F to 158 °F (-40 °C to 70 °C)

Battery Charging Temperature  32 °F to 104 °F (0 °C to +40 °C) ambient temperature range.

Humidity 5% to 95% non condensing

Drop Specification Multiple 1.2 m (4 ft.) drops to concrete across operating temperature range

Tumble 500 half-meter tumbles at room temperature (1,000 drops)

Environmental Sealing IP54

ESD ± 15k VDC air discharge

± 8k VDC direct discharge

± 8k VDC indirect discharge

WLAN Wireless Data Communications

WLAN radio 802.11a/b/g/n

Operating Channels Channel 8 - 169 (5040 - 5845 MHz) (4920 - 4980 MHz) Japan only

Channel 1 - 13 (2412 - 2472 MHz)

Channel 14 (2484 MHz) Japan only

Actual operating frequencies depend on regulatory rules and certification 
agency

Security Security Modes: Legacy, WPA and WPA2

Encryption: WEP (40 or 128 bit), TKIP and AES

Authentication: TLS, TTLS (MS-CHAP), TTLS (MS-CHAP v2), TTLS (CHAP), 
TTLS (MD5), TTLS (PAP), PEAP-TLS, PEAP (MSCHAP v2), PEAP 
(EAP-GTC), EAP-FAST-TLS, EAP-FAST (MS-CHAP v2), WEAP-FAST 
(EAP-GTC) and LEAP

Voice Communication Runs voice recognition engines and text-to-speech engines for voice picking 
applications

Output Power 100 mW U.S. and International

Data Rate 802.11a: up to 54Mb per second

802.11b: up to 11Mb per second

802.11g: up to 54Mb per second

802.11n: up to 72.2 Mb per second

Table A-1    Technical Specifications (Continued)

Item Description
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RS309 Scanner

Frequency Range 802.11a: 5 GHz; country-dependent

802.11b: 2.4 GHz; country-dependent

802.11g: 2.4 GHz; country-dependent

802.11n: 2.4 GHz; country-dependent

Antenna Internal

WPAN Wireless Data Communications

Bluetooth Bluetooth Version 2.1 +EDR

Table A-1    Technical Specifications (Continued)

Item Description

Table A-2    RS309 Technical Specifications

Item Description

Physical and Environmental Characteristics

Dimensions (standard version 
without cables attached)

6.8 cm L x 6.1 cm H x 3.8 cm

(2.7 inch L x 2.4 inch W x 1.5 inch H)

Weight (standard version 
without cables attached)

98 g (3.525 oz.)

Current 140 mA typical, 180 mA max

Standby Current 60 µA max

Voltage 3.1 to 3.6 VDC

Vcc Noise Level 200 mV p-p max.

Performance Characteristics

Light Source 650 nm LASER, 1.06 mW

Scan Rate 35 (± 5) scans/sec (bidirectional)

Yaw ± 50 degrees from normal

Roll ± 20 degrees from vertical

Pitch ± 65 degrees from normal

User Environment

Operating Temperature -22 °F to 122 °F (-30 °C to 50 °C)

Storage Temperature -40 °F to 140 °F (-40 °C to 60 °C)

Humidity 5% to 95% non condensing
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RS409 Scanner

Drop Specification 4 ft.(1.8m) drop to concrete

Environmental Sealing IP54 sealing

Ambient Light Immunity Tolerant to typical artificial indoor and natural outdoor (direct sunlight) lighting 
conditions.

Fluorescent, Incandescent, Mercury Vapor, Sodium Vapor, LED1: 450 foot 
candles (4,844 lux)

Sunlight: 8000 foot candles (86,111 lux)
1 LED lighting with high AC ripple content can impact scanning performance.

Table A-2    RS309 Technical Specifications (Continued)

Item Description

Table A-3    RS409 Technical Specifications

Item Description

Physical and Environmental Characteristics

Dimensions (4.8 cm L x 3.6 cm H x 4.8 cm H)

1.9 in. L x 1.4 in. W x 1.9 in. H

Weight (standard version 
without cables attached)

56.7 gm (2.0 oz.)

Current 92 mA typical, 121 mA max

Standby Current 12 µA typical/60 µA max

Voltage 3.1 to 3.6 VDC

Vcc Noise Level 100 mV p-p max.

Performance Characteristics

Light Source 650 nm LASER, 1.55 mW

Scan Rate 104 (± 12) scans/sec (bidirectional)

Scan Angle Programmable: 35° and 47°

Yaw ± 50 degrees from normal

Roll ± 35 degrees from vertical

Pitch ± 65 degrees from normal

User Environment

Operating Temperature -20 °C to 50 °C (-4 °F to 122 °F)

Storage Temperature -40 °C to 70 °C (-25 °F to 160 °F)

Humidity 5% to 95% non condensing
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RS419 Scanner

Drop Specification 1.8m (4 ft.) drop to concrete

Environmental Sealing IP54 sealing

Ambient Light Immunity Tolerant to typical artificial indoor and natural outdoor (direct sunlight) lighting 
conditions.

Fluorescent, Incandescent, Mercury Vapor, Sodium Vapor, LED1: 450 foot candles 
(4,844 lux)

Sunlight: 8000 foot candles (86,111 lux)
1 LED lighting with high AC ripple content can impact scanning performance.

Table A-3    RS409 Technical Specifications (Continued)

Item Description

Table A-4    RS419 Technical Specifications

Item Description

Physical and Environmental Characteristics

Dimensions 4.8 cm L x 3.6 cm H x 4.8 cm H

(1.9 in. L x 1.4 in. W x 1.9 in. H)

Weight (standard version 
without cables attached)

56.7 gm (2.0 oz.)

Current 92 mA typical, 121 mA max

Standby Current 12µA typical/60 µA max

Voltage 3.1 to 3.6 VDC

Vcc Noise Level 100 mV p-p max.

Performance Characteristics

Light Source 650 nm LASER, 1.77 mW peak power

Scan Rate 104 (± 12) scans/sec (bidirectional)

Scan Angle Programmable: 10°,35° and 47°

Yaw ± 40 degrees from normal

Roll ± 35 degrees from vertical

Pitch ± 65 degrees from normal

User Environment

Operating Temperature -20 °C to 60 °C (-4 °F to 140 °F)

Storage Temperature -40 °C to 70 °C (-25 °F to 160 °F)

Humidity 5% to 95% non condensing
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RS507 Scanner

Drop Specification Multiple 1.2 m (4 ft.) drop to concrete from -20 °C to 50 °C (-4 °F to 122 °F).

Multiple 0.9 m (3 ft.) drop to concrete at (-30 °C (-22 °F).

Environmental Sealing IP54

Ambient Light Immunity Tolerant to typical artificial indoor and natural outdoor (direct sunlight) lighting 
conditions.

Fluorescent, Incandescent, Mercury Vapor, Sodium Vapor, LED1: 450 foot candles 
(4,844 lux)

Sunlight: 8000 foot candles (86,111 lux)
1 LED lighting with high AC ripple content can impact scanning performance.

Table A-4    RS419 Technical Specifications (Continued)

Item Description

Table A-5    RS507 Technical Specifications

Item Description

Physical and Environmental Characteristics

Dimensions Triggerless, standard battery: 2.9 x 5.3 x 7.4 cm (1.16 x 2.1 x 2.92 in.)

Triggerless, extended battery: 3.6 x 5.3 x 7.4 cm (1.42 x 2.1 x 2.92 in.)

Triggered, standard battery: 2.9 x 5.3 x 7.4 cm (1.16 x 2.1 x 2.92 in.)

Triggered, corded (cord length not included): 3.3 x 5.3 x 7.4 cm (1.3 x 2.1 x 2.92 in.)

Weight Triggerless, standard battery: 121.4 g (4.3 oz.)

Triggerless, extended battery: 146.4 g (5.2 oz.)

Triggered, standard battery: 134.8 g (4.8 oz.)

Triggered, corded: 140.8 g (5.0 oz.)

Performance Characteristics

Optical Resolution WVGA 752 H x 480 V pixels (gray scale)

Skew ± 60° from normal

Roll 360°

Pitch ± 60° from normal

Aiming Element 655 nm ± 10 nm Visible Laser Diode

Illumination Element 637 nm ± 5 nm Red LEDs

Field of View Horizontal: 39.6°; Vertical: 25.7°

Nominal Working 
Distance

Density 5 mil 7.5 mil 20 mil 13 mil
1D Code Type 39 39 39 UPC
Near 2” 1.5”
Far 7.4” 10.5” 24.6” 15.4”

Density 6.67 mil 10 mil 15 mil
2D Code Type PDF417 PDF417 PDF417
Near 3.3”
Far 7.0” 10” 14.6”
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Ambient Light Immunity From total darkness

Indoor: 450 ft. candles (4,845 lux).

Outdoor: 9,000 ft. candles (96,900 lux).

Motion Tolerance 63.5 cm (25 inches) per second, typical.

Supported Symbologies Codabar, Code 39, Code 128, EAN-13, EAN-8, Interleaved 2 of 5, UPC-A and 
UPC-E.

Code 11, Code 32 Pharmaceutical (PARAF), Code 93, MSI, Reduced Space 
Symbology (RSS-14, RSS Limited, RSS Expanded), Straight 2 of 5 IATA (two-bar 
start/stop), Straight 2 of 5 Industrial (three-bar start/stop), Trioptic, UPC-E1.

4-CB (4-State Customer Bar code), Aztec, MicroPDF417, PDF417, MaxiCode.

Australian Post, British Post (4 state code and “infomail”), Data Matrix, Japanese 
Post, KIX (Netherlands) Post, Planet Code, Postnet, QR Code, EAN/UCC 
Composite, TCIF Linked Code 39 (TLC39).

Supported Aiming Modes Class 2 Laser, cross hair with bright center for sunlight visibility; Pick List mode 
option.

Interface Cordless:

Bluetooth: Class II, v 2.1 with Adaptive Frequency Hopping (AFH).

Supported profiles: Serial Port Profile (SPP), Human Interface Device Profile (HID), 
Service Discovery Application Profile (SDAP).

Pairing: by reading terminal BT address as bar code off the display or from a printed 
label.

Corded (to WT41N0): Serial.

User Interface

LED Two (parallel), multi color, rear left and rear right.

Beeper Rear center, up to 80 dBA SPL @ 10 cm.

Restore Key User accessible for emergency boot up and Bluetooth reconnect (after excessive 
disconnection period).

Scan Triggering Manual or automatic using Interactive Sensing Technology (IST).

User Environment

Operating Temperature -20 °C to 55 °C (-4 °F to 131 °F)

Storage Temperature -40° to 70° C (-40° to 158° F) excluding battery

-40° to 60° C (-40° to 140° F) including battery

Humidity 5% to 85% non condensing

Drop Specification 1.8 m (6 ft.) multiple drops to concrete across operating temperature range.

Environmental Sealing IP54

Electrostatic Discharge

(ESD)

±15kV air discharge, ±8kV direct discharge.

Table A-5    RS507 Technical Specifications (Continued)

Item Description
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RS5000 Scanner

Power

Cordless Standard battery: Li-Ion 970 mAh, 3.7 V with up to 35,000 scans (continuous) or up 
to 10 hours with 900 scans per hour on a single charge using fresh batteries.

Extended battery: Li-Ion 1940 mAh, 3.7 V with up to 70,000 scans (continuous) or up 
to 20 hours with 900 scans per hour on a single charge using fresh batteries.

Corded Corded adaptor to WT41N0.

Table A-5    RS507 Technical Specifications (Continued)

Item Description

Table A-6    RS5000 Technical Specifications

Item Description

Physical and Environmental Characteristics

Dimensions 51.5 mm L x 32 mm W x 27.5 mm D

(2.0 in. L x 1.26 in. W x 1.1 in. D)

Weight (standard version 
without cables attached

50 g (1.8 oz.)

Current 450 mA typical, 500 mA max

Standby Current 0.60 mA

Voltage 3.1 to 3.6 VDC

Vcc Noise Level 100 mV p-p max.

Performance Characteristics

Aiming Element 610 nm LED

Illumination One Hyper Red 660 nm LED

Field of View Horizontal: 42°, Vertical: 28° 

Roll 360 degrees

Pitch ± 60 degrees from normal

Skew ± 60 degrees from normal

User Environment

Operating Temperature -30 °C to 50 °C (-22 °F to 122 °F)

Storage Temperature -40 °C to 60 °C (-25 °F to 140 °F)

Humidity 5% to 95% non condensing
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Accessories

Drop Specification Multiple 1.2 m (4 ft.) drops to concrete from -30 °C to 50 °C (-22 °F to 122 °F).

Environmental Sealing IP54

Ambient Light Immunity Tolerant to typical artificial indoor and natural outdoor (direct sunlight) lighting 
conditions.

Fluorescent, Incandescent, Mercury Vapor, Sodium Vapor, LED1: 450 foot candles 
(4,844 lux)

Sunlight: 9000 foot candles (96,900 lux)
1 LED lighting with high AC ripple content can impact scanning performance.

Table A-6    RS5000 Technical Specifications (Continued)

Item Description

Table A-7    Single Slot USB Cradle Specification

Feature Description

Operating Temperature 0 °C to +50 ° (C32 °F to 122 °F)

Storage Temperature -40 °C to 70 °C (-40 °F to 158 °F)

Battery Charging Temperature 0 °C to +40 °C (32 °F to 104 °F) ambient temperature

Humidity 5% to 95% non-condensing

Size (L x W x H) 16.8 cm x 13.0 cm x 9.9 cm (6.6 in. x 5.1 in. x 3.9 in.)

Weight 344 gm (12.1 oz.)

Power Supply 12 VDC, 3.3 A

Drop 76.2 cm (30 inches) to vinyl covered concrete

Electrostatic Discharge (ESD) ±15 kV air discharge, ± 8 kV contact discharge

Typical Power 20 W

Table A-8    Four Slot Ethernet Cradle Specification

Feature Description

Operating Temperature 0 °C to +50 °C (32 °F to 122 °F)

Storage Temperature -40 °C to 70 °C (-40 °F to 158 °F)

Battery Charging Temperature 0 °C to +40 °C (32 °F to 104 °F) ambient temperature

Humidity 5% to 95% non-condensing

Size (L x W x H) 17.0 cm x 48.1 cm x 11.4 cm (6.7 in. x 18.9 in. x 4.5 in.)

Weight 1300 gm (45.9 oz.)

Power Supply 12 VDC, 9 A
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Drop 76.2 cm (30 inches) to vinyl covered concrete

Electrostatic Discharge (ESD) ±15 kV air discharge, ± 8 kV contact discharge

Typical Power 60 W

Table A-9    Four Slot Spare battery Charger Specification

Feature Description

Operating Temperature 0 °C to +40 °C (32 °F to 104 °F)

Storage Temperature -40 °C to 70 °C (-40 °F to 158 °F)

Battery Charging Temperature 0 °C to +40 °C (32 °F to 104 °F) ambient temperature

Humidity 5% to 95% non-condensing

Size (L x W x H) 21.5 cm x 14.5 cm x 4.9 cm (8.5 in. x 5.7 in. x 1.9 in.)

Weight 435 gm (15.3 oz.)

Power Supply 12 VDC, 3.3 A

Drop 76.2 cm (30 inches) to vinyl covered concrete

Electrostatic Discharge (ESD) ±15 kV air discharge, ± 8 kV contact discharge

Typical Power 25 W

Table A-8    Four Slot Ethernet Cradle Specification (Continued)

Feature Description
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Wearable Terminal Interface Connector Pin-Outs

Figure A-1    Pin Locations

Table A-10    Interface Connector Pin-Outs 

PIN Signal Name Function

1 SCANNER_DETECT_RIGHT Scanner detect.

2 USBH_N_RIGHT USB host negative.

3 GND Digital/system ground.

4 USBH_P_RIGHT USB host positive.

5 A_GND Analog ground.

6 HPOUTL_RIGHT_MIC+ Mic+ (default) or headphone out left.

7 U2_RXD Scanner serial RXD.

8 HPOUTER_RIGHT Headphone out right.

9 U2_TXD Scanner serial TXD.

10 SCAN_PWR Scanner 3.3 VDC power out.

11 U2_CTS Scanner serial CTS (default if laser scanner plugged in), or 
Audio Ground sense/MIC- (default if audio connector plugged 
in).

12 U2_RTS Scanner serial RTS.

Pin 1
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Figure A-2    Cradle Connector Pin Locations

Table A-11    Cradle Connector Pin-Outs 

PIN Number Signal Name Function

1 Power In 5.4 VDC input power.

2 ACC_OTG_VBUS 5.0 VDC input in client mode, 5.0 VDC output in host mode.

3 ACC_OTG_DP USB data positive.

4 ACC_OTG_DM USB data negative.

5 System GND System ground.

6 ACC_OTG_ID USB host/client ID pin input. (Low = USB Host, High = USB Client).

7 System Ground System ground.

Pin 1
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Decode Zones

RS309

The RS309 has a selectable scan angle of either 30° or 42°. The 30° scan angle decodes are shown in Figure 
A-3 and the 42° scan angle decodes are shown in Figure A-4. Table A-12 lists the typical distances for the 30° 
and 42° scan angles for selected bar code densities. The minimum element width (or “symbol density”) is the 
width in mils of the narrowest element (bar or space) in the symbol.

Figure A-3    RS309 30° Decode Zones
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Figure A-4    RS309 42° Decode Zones

Table A-12     RS309 Decode Distances

Symbol Density/
Bar Code Type/

W-N Ratio
Bar Code Content/

ContrastNote 1

Typical 30° Working 
Ranges

Typical 42° Working 
Ranges

Near Far Near Far

5.0 mil

Code 39; 2.5:1

ABCDEFGH

80% MRD

4.25 in.

10.79 cm

8.00 in.

20.32 cm

4.50 in

11.43 cm

9.25 in

23.5 cm

7.5 mil

Code 39; 2.5:1

ABCDEF

80% MRD

3.75 in.

9.53 cm

13.50 in.

34.29 cm

4.25 in

10.79 cm

14.75 in

37.47 cm

13 mil

100% UPC

012345678905

80% MRD

2.75 in.

6.98 cm

26.75 in.

67.95 cm

3.25 in

8.26 cm

26.00 in

66.04 cm

Notes:
1. CONTRAST measured as Mean Reflective Difference (MRD) at 650 nm.
2. Near ranges on lower densities are largely dependent upon the width of the bar code and the scan angle.
3. Working range specifications: Photographic quality symbols, pitch = 10°, skew = 0°, roll = 0°, 
ambient light < 150 ft. candles, and temperature = 23°C
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20 mil

Code 39; 2.2:1

123

80% MRD

2.25 in.

5.72 cm

(Note 2)

41.50 in.

105 cm

2.00 in 

5.08 cm

(Note 2)

41.50 in

105.41 cm

20 mil

Code 39; 2.2:1

123

25% MRD

2.25 in.

5.72 cm

(Note 2)

30.50 in.

77.5 cm

2.00 in 

5.08 cm

(Note 2)

30.50 in

77.5 cm

40 mil

Code 39; 2.2:1

AB

80% MRD

4.00 in.

10.16 cm

(Note 2)

72.00 in.

182.88 cm

3.25 in

8.26 cm

(Note 2)

70.75 in

179.79 cm

55 mil

Code 39; 2.2:1

CD

80% MRD

5.75 in.

14.6 cm

(Note 2)

86.25 in.

233.05 cm

4.50 in

11.43 cm

(Note 2)

86.00 in

228.6 cm

Table A-12     RS309 Decode Distances (Continued)

Symbol Density/
Bar Code Type/

W-N Ratio
Bar Code Content/

ContrastNote 1

Typical 30° Working 
Ranges

Typical 42° Working 
Ranges

Near Far Near Far

Notes:
1. CONTRAST measured as Mean Reflective Difference (MRD) at 650 nm.
2. Near ranges on lower densities are largely dependent upon the width of the bar code and the scan angle.
3. Working range specifications: Photographic quality symbols, pitch = 10°, skew = 0°, roll = 0°, 
ambient light < 150 ft. candles, and temperature = 23°C
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RS409

Figure A-5 and Figure A-6 show the decode zone for the RS409. The figures are typical values. Table A-13 
lists the typical distances for selected bar code densities. The minimum element width (or “symbol density”) is 
the width in mils of the narrowest element (bar or space) in the symbol.

Figure A-5    RS409 35° Decode Zone
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Figure A-6    RS409 47° Decode Zone

Table A-13     RS409 Decode Distances

Symbol 
Density/

Bar Code Type/
W-N Ratio

Bar Code Content/
ContrastNote 1

35 ° Typical Working Ranges 47 ° Typical Working 
Ranges

Near Far Near Far

4.0 mil
Code 39; 2.5:1

ABCDEFGH
80% MRD

1.50 in
3.81 cm

5.50 in
13.97 cm

1.00 in
2.50 cm

5.50 in
13.97 cm

5.0 mil
Code 39; 2.5:1

ABCDEFGH
80% MRD

1.80 in
4.57 cm

8.00 in
20.32 cm

1.25 in
3.18 cm

8.00 in
20.32 cm

7.5 mil
Code 39; 2.5:1

ABCDEF
80% MRD

2.20 in
5.59 cm

13.00 in
33.02 cm

1.50 in
3.81 cm

13.00 in
33.02 cm

10 mil
Code 39; 2.5:1

ABCDE
90% MRD

2.20 in
5.59 cm

18.00 in
45.72 cm

1.50 in
3.81 cm

18.00 in
45.72 cm
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13 mil
100% UPC

12345678905
90% MRD

2.20 in
5.59 cm

24.00 in
60.96 cm

1.50 in
3.81 cm

24.00 in
60.96 cm

15 mil
Code 39; 2.5:1

ABCD
80% MRD

2.20 in
5.59 cm

28.00 in
71.12 cm

1.50 in
3.81 cm

28.00 in
71.12 cm

20 mil
Code 39; 2.2:1

123
80% MRD

2.50 in
6.35 cm

29.00 in
73.66 cm

1.75 in
4.45 cm

33.00 in
83.82 cm

40 mil
Code 39; 2.2:1

AB
80% MRD

X 33.00 in
83.82 cm

X 36.00 in
91.44 cm

55 mil
Code 39; 2.2:1

CD
80% MRD

X 42.00 in
106.68 cm

X 45.00 in
114.30 cm

Notes:
1. CONTRAST measured as Mean Reflective Difference (MRD) at 650 nm.
2. Near ranges on lower densities (not specified) are largely dependent upon the width of the bar 
code and the scan angle.
3. Working range specifications at ambient temperature (23°C), Photographic quality symbols. 
pitch=10°, roll=0°, skew=0°, ambient light < 150 ft-candles.
4. X - Dependent on width of bar code.
5. Distances measured from front edge of chassis.

Table A-13     RS409 Decode Distances (Continued)

Symbol 
Density/

Bar Code Type/
W-N Ratio

Bar Code Content/
ContrastNote 1

35 ° Typical Working Ranges 47 ° Typical Working 
Ranges

Near Far Near Far
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RS419

Figure A-7 shows the decode zone for the RS419. The figures are typical values. Table A-14 lists the typical 
distances for selected bar code densities. The minimum element width (or “symbol density”) is the width in mils 
of the narrowest element (bar or space) in the symbol.

Figure A-7    RS419 Decode Zone
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Table A-14    RS419 Decode Distances

Symbol Density/
Bar Code Type/

W-N Ratio
Bar Code Content/

ContrastNote 1
Typical Working Ranges

Near Far

5.0 mil

Code 128

1234

80% MRD

1.2 in

3.05 cm

7.7 in

19.56 cm

5.0 mil

Code 39; 2.5:1

ABCDEFGH

80% MRD

1.2 in

3.05 cm

12.5 in

31.75 cm

7.5 mil

Code 39; 2.5:1

ABCDEF

80% MRD

1.1 in

2.79 cm

18.5 in

46.99 cm

10 mil

Code 128

1234

80% MRD

1.2 in

3.05 cm

Note 3

19.0 in

48.26 cm

13 mil

100% UPC

12345678905

80% MRD

1.6 in

4.06 cm

27.0 in

68.58 cm

15 mil

Code 128

1234

80% MRD

1.0 in

2.54 cm

Note 3

29.5 in

74.93 cm

20 mil

Code 39; 2.2:1

123

80% MRD

1.4 in

3.56 cm

Note 3

52.0 in

132.08 cm

55 mil

Code 39; 2.2:1

CD

80% MRD

3.4 in

8.64 cm

Note 3

100.0 in

254.00 cm

100 mil

Code 39; 3.0:1 reflective

123456

80% MRD

2 ft

60.96cm

Note 3

17 ft

518.16 cm

Notes:

1. Contrast measured as Mean Reflective Difference (MRD) at 650 nm.

2. Working range specifications at ambient temperature (23°C), photographic quality symbols. 
Pitch=10°, roll=0°, skew=0°, ambient light < 150 ft-candles using Symbol or equivalent decoder.

3. Dependent on width of bar code.

4. Distances measured from front edge of scan engine chassis.



APPENDIX B SOFTWARE SETUP
Bluetooth Configuration Setting
The wearable terminal supports both the Microsoft Bluetooth stack and the StoneStreet One Bluetooth stack. 
Only one Bluetooth stack can be used at a time. By default, the StoneStreet One Bluetooth stack is enabled. A 
registry key on the wearable terminal can be modified to disable the StoneStreet One stack and enable the 
Microsoft stack.

Using a registry editor, navigate to the following:

[HKEY_LOCAL_MACHINE\Software\SymbolBluetooth

Edit the following key:

“SSStack”=dword:1

where:

0 = enable Microsoft stack and disable StoneStreet One stack (default)

1 = enable StoneStreet One stack and disable Microsoft stack

After setting the registry key, warm boot the wearable terminal.
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GLOSSARY
Numeric

802.11. A group of wireless specifications developed by the Institute of Electrical and Electronics Engineers (IEEE). It 
specifies an over-the-air interface between a wireless client and a base station or between two wireless clients.

802.11a. Operates in the 5 GHz frequency range (5.125 to 5.85 GHz) with a maximum 54Mbit/sec. signaling rate. The 
5 GHz frequency band is not as crowded as the 2.4 GHz frequency because it offers significantly more radio 
channels than the 802.11b and is used by fewer applications. It has a shorter range than 802.11g and is not 
compatible with 802.11b.

802.11b. Operates in the 2.4 GHz Industrial, Scientific and Measurement (ISM) band (2.4 to 2.4835 GHz) and provides 
signaling rates of up to 11Mbit/sec. This is a very commonly used frequency. Microwave ovens, cordless phones, 
medical and scientific equipment, as well as Bluetooth devices, all work within the 2.4 GHz ISM band.

802.11g. Similar to 802.11b, but this standard supports signaling rates of up to 54Mbit/sec. It also operates in the heavily 
used 2.4 GHz ISM band but uses a different radio technology to boost overall throughput. Compatible with the 
802.11b. 

A

Access Point. Provides a bridge between Ethernet wired LANs and the wireless network. Access points are the 
connectivity point between Ethernet wired networks and devices (laptops, hand-held computers, point-of-sale 
terminals) equipped with a wireless LAN adapter card.

Ad Hoc Mode. A wireless network framework in which devices communicate directly with one another without using an 
access point.

API. An interface by means of which one software component communicates with or controls another. Usually used to 
refer to services provided by one software component to another, usually via software interrupts or function calls

Application Programming Interface. See API.
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ANSI Terminal. A display terminal that follows commands in the ANSI standard terminal language. For example, it uses 
escape sequences to control the cursor, clear the screen and set colors. Communications programs support the 
ANSI terminal mode and often default to this terminal emulation for dial-up connections to online services.

Association. The process of determining the viability of the wireless connection and establishing a wireless network's 
root and designated access points. A wearable terminal associates with its wireless network as soon as it is powered 
on or moves into range.

Autodiscrimination. The ability of an interface controller to determine the code type of a scanned bar code. After this 
determination is made, the information content is decoded.

B

Bar Code. A pattern of variable-width bars and spaces which represents numeric or alphanumeric data in 
machine-readable form. The general format of a bar code symbol consists of a leading margin, start character, data 
or message character, check character (if any), stop character, and trailing margin. Within this framework, each 
recognizable symbology uses its own unique format. See Symbology.

Bit. Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits compose one byte of 
data. The pattern of 0 and 1 values within the byte determines its meaning.

Bits per Second (bps). Bits transmitted or received.

Bluetooth. A low-cost, short-range radio link between two devices. Bluetooth can replace cables and can be used to 
create ad hoc networks and provide a standard way to connect devices.

Bit. Binary digit. One bit is the basic unit of binary information. Generally, eight consecutive bits compose one byte of 
data. The pattern of 0 and 1 values within the byte determines its meaning.

bps.  See Bits Per Second.

Byte. On an addressable boundary, eight adjacent binary digits (0 and 1) combined in a pattern to represent a specific 
character or numeric value. Bits are numbered from the right, 0 through 7, with bit 0 the low-order bit. One byte in 
memory is used to store one ASCII character.

boot or boot-up. The process a computer goes through when it starts. During boot-up, the computer can run 
self-diagnostic tests and configure hardware and software.

C

CAM. (Continuously Aware Mode) Mode in which the adapter is instructed to continually check for network activity.

CDRH. (Center for Devices and Radiological Health) A federal agency responsible for regulating laser product safety. 
This agency specifies various laser operation classes based on power output during operation.

CDRH Class 1. This is the lowest power CDRH laser classification. This class is considered intrinsically safe, even if all 
laser output were directed into the eye's pupil. There are no special operating procedures for this class.

CDRH Class 2. No additional software mechanisms are needed to conform to this limit. Laser operation in this class 
poses no danger for unintentional direct human exposure.
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CHAP. (Challenge Handshake Authentication Protocol) A type of authentication in which the authentication agent 
(typically a network server) sends the client program a random value that is used only once and an ID value. Both 
the sender and peer share a predefined secret. The peer concatenates the random value (or nonce), the ID and the 
secret and calculates a one-way hash using MD5. The hash value is sent to the authenticator, which in turn builds 
that same string on its side, calculates the MD5 sum itself and compares the result with the value received from the 
peer. If the values match, the peer is authenticated. 

Character. A pattern of bars and spaces which either directly represents data or indicates a control function, such as a 
number, letter, punctuation mark, or communications control contained in a message.

Character Set. Those characters available for encoding in a particular bar code symbology.

Check Digit. A digit used to verify a correct symbol decode. The scanner inserts the decoded data into an arithmetic 
formula and checks that the resulting number matches the encoded check digit. Check digits are required for UPC 
but are optional for other symbologies. Using check digits decreases the chance of substitution errors when a 
symbol is decoded.

Cold Boot. A cold boot restarts the wearable terminal and erases all user stored records and entries.

COM port.  Communication port; ports are identified by number, e.g., COM1, COM2.

Continuous Code. A bar code or symbol in which all spaces within the symbol are parts of characters. There are no 
intercharacter gaps in a continuous code. The absence of gaps allows for greater information density.

Cradle. A cradle is used for charging the terminal battery and for communicating with a host computer, and provides a 
storage place for the terminal when not in use.

D

Data Communications Equipment (DCE). A device (such as a modem) which is designed to attach directly to a DTE 
(Data Terminal Equipment) device.

DCE. See Data Communications Equipment.

Decode. To recognize a bar code symbology (e.g., UPC/EAN) and then analyze the content of the specific bar code 
scanned.

Decode Algorithm. A decoding scheme that converts pulse widths into data representation of the letters or numbers 
encoded within a bar code symbol.

Decryption. Decryption is the decoding and unscrambling of received encrypted data. Also see, Encryption and Key.

Depth of Field. The range between minimum and maximum distances at which a scanner can read a symbol with a 
certain minimum element width.

DTE. See Data Terminal Equipment.
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E

EAN. (European Article Number) This European/International version of the UPC provides its own coding format and 
symbology standards. Element dimensions are specified metrically. EAN is used primarily in retail.

EAP. (Extensible Authentication Protocol) A general authentication protocol used to control network access. Many 
specific authentication methods work within this framework. 

EAP-PEAP. (Extensible Authentication Protocol-Protected Extensible Authentication Protocol) A mutual authentication 
method that uses a combination of digital certificates and another system, such as passwords. 

EAP-TLS. (Extensible Authentication Protocol-Transport Layer Security) A mutual authentication method that uses 
digital certificates. 

Encoded Area. Total linear dimension occupied by all characters of a code pattern, including start/stop characters and 
data.

Encryption. Encoding data to prevent it from being read by unauthorized people. 

ENQ (RS-232). ENQ software handshaking is also supported for the data sent to the host.

EMDK. Enterprise Mobility Developer’s Kit.

Ethernet . An IEEE standard network protocol that specifies how data is placed on and retrieved from a common 
transmission medium. 

ESD. Electro-Static Discharge

F

Flash Disk. An additional megabyte of non-volatile memory for storing application and configuration files. 

Flash Memory. Flash memory is nonvolatile, semi-permanent storage that can be electronically erased in the circuit 
and reprogrammed. 

File Transfer Protocol (FTP). A TCP/IP application protocol governing file transfer via network or telephone lines. See 
TCP/IP.

H

Hard Reset. See Cold Boot.

Hz. Hertz; A unit of frequency equal to one cycle per second.

Host Computer. A computer that serves other terminals in a network, providing such services as computation, 
database access, supervisory programs and network control.
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I

IEC. International Electrotechnical Commission. This international agency regulates laser safety by specifying various 
laser operation classes based on power output during operation.

IEC (825) Class 1. This is the lowest power IEC laser classification. Conformity is ensured through a software restriction 
of 120 seconds of laser operation within any 1000 second window and an automatic laser shutdown if the scanner's 
oscillating mirror fails. 

IEEE Address. See MAC Address.

Internet Protocol Address. See IP.

I/O Ports. interface The connection between two devices, defined by common physical characteristics, signal 
characteristics, and signal meanings. Types of interfaces include RS-232 and PCMCIA.

Input/Output Ports.  I/O ports are primarily dedicated to passing information into or out of the terminal’s memory. Series 
9000 wearable terminals include Serial and USB ports.

IP. (Internet Protocol) The IP part of the TCP/IP communications protocol. IP implements the network layer (layer 3) of 
the protocol, which contains a network address and is used to route a message to a different network or subnetwork. 
IP accepts “packets” from the layer 4 transport protocol (TCP or UDP), adds its own header to it and delivers a 
“datagram” to the layer 2 data link protocol. It may also break the packet into fragments to support the maximum 
transmission unit (MTU) of the network.

IP Address. (Internet Protocol address) The address of a computer attached to an IP network. Every client and server 
station must have a unique IP address. A 32-bit address used by a computer on a IP network. Client workstations 
have either a permanent address or one that is dynamically assigned to them each session. IP addresses are written 
as four sets of numbers separated by periods; for example, 204.171.64.2.

IPX/SPX. Internet Package Exchange/Sequential Packet Exchange. A communications protocol for Novell. IPX is 
Novell’s Layer 3 protocol, similar to XNS and IP, and used in NetWare networks. SPX is Novell's version of the Xerox 
SPP protocol.

IS-95. Interim Standard 95. The EIA/TIA standard that governs the operation of CDMA cellular service. Versions include 
IS-95A and IS-95B. See CDMA.

K

Key. A key is the specific code used by the algorithm to encrypt or decrypt the data. Also see, Encryption and 
Decrypting.

L

laser scanner. A type of bar code reader that uses a beam of laser light.
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LASER.  (Light Amplification by Stimulated Emission of Radiation) The laser is an intense light source. Light from a laser 
is all the same frequency, unlike the output of an incandescent bulb. Laser light is typically coherent and has a high 
energy density.

LCD. See Liquid Crystal Display.

LEAP. (Lightweight Extensible Authentication Protocol) A mutual authentication method that uses a username and 
password system.

LED Indicator. A semiconductor diode (LED - Light Emitting Diode) used as an indicator, often in digital displays. The 
semiconductor uses applied voltage to produce light of a certain frequency determined by the semiconductor's 
particular chemical composition.

Liquid Crystal Display (LCD). A display that uses liquid crystal sealed between two glass plates. The crystals are 
excited by precise electrical charges, causing them to reflect light outside according to their bias. They use little 
electricity and react relatively quickly. They require external light to reflect their information to the user.

M

MC. Mobile computer.

MDN. (Mobile Directory Number) The directory listing telephone number that is dialed (generally using POTS) to reach 
a mobile unit. The MDN is usually associated with a MIN in a cellular telephone -- in the US and Canada, the MDN 
and MIN are the same value for voice cellular users. International roaming considerations often result in the MDN 
being different from the MIN.

MIL. 1 mil = 1 thousandth of an inch.

MIN. (Mobile Identification Number) The unique account number associated with a cellular device. It is broadcast by the 
cellular device when accessing the cellular system.

MS CHAP. (Microsoft Challenge Handshake Authentication Protocol) is the Microsoft version of CHAP and is an 
extension to RFC 1994. Like the standard version of CHAP, MS-CHAP is used for PPP authentication; in this case, 
authentication occurs between a PC using Microsoft Windows NT or Microsoft Windows 95 and a Cisco router or 
access server acting as a network access server (NAS).

N

Nominal. The exact (or ideal) intended value for a specified parameter. Tolerances are specified as positive and 
negative deviations from this value.

Nominal Size. Standard size for a bar code symbol. Most UPC/EAN codes are used over a range of magnifications 
(e.g., from 0.80 to 2.00 of nominal).

NVM. Non-Volatile Memory.
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O

ODI. See Open Data-Link Interface.

Open Data-Link Interface (ODI). Novell’s driver specification for an interface between network hardware and 
higher-level protocols. It supports multiple protocols on a single NIC (Network Interface Controller). It is capable of 
understanding and translating any network information or request sent by any other ODI-compatible protocol into 
something a NetWare client can understand and process.

Open System Authentication. Open System authentication is a null authentication algorithm.

P

PAN . Personal area network. Using Bluetooth wireless technology, PANs enable devices to communicate wirelessly. 
Generally, a wireless PAN consists of a dynamic group of less than 255 devices that communicate within about a 
33-foot range. Only devices within this limited area typically participate in the network. 

Parameter. A variable that can have different values assigned to it.

PING. (Packet Internet Groper) An Internet utility used to determine whether a particular IP address is online. It is used 
to test and debug a network by sending out a packet and waiting for a response.

Programming Mode. The state in which a scanner is configured for parameter values. See Scanning Mode.

Q

Quiet Zone. A clear space, containing no dark marks, which precedes the start character of a bar code symbol and 
follows the stop character.

R

RAM. Random Access Memory. Data in RAM can be accessed in random order, and quickly written and read.

RF. Radio Frequency.

ROM. Read-Only Memory. Data stored in ROM cannot be changed or removed.

Router. A device that connects networks and supports the required protocols for packet filtering. Routers are typically 
used to extend the range of cabling and to organize the topology of a network into subnets. See Subnet.

RS-232. An Electronic Industries Association (EIA) standard that defines the connector, connector pins, and signals 
used to transfer data serially from one device to another.
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S

Scanner. An electronic device used to scan bar code symbols and produce a digitized pattern that corresponds to the 
bars and spaces of the symbol. Its three main components are:
1. Light source (laser or photoelectric cell) - illuminates a bar code.
2. Photodetector - registers the difference in reflected light (more light reflected from spaces).
3. Signal conditioning circuit - transforms optical detector output into a digitized bar pattern.

Scanning Mode. The scanner is energized, programmed and ready to read a bar code.

Scanning Sequence. A method of programming or configuring parameters for a bar code reading system by scanning 
bar code menus.

SDK. Software Development Kit

Secure Sockets Layer (SSL). SSL is a commonly-used protocol for managing the security of a message transmission 
on the Internet. SSL uses a program layer located between the Internet's Hypertext Transfer Protocol (HTTP) and 
Transport Control Protocol (TCP) layers. SSL is included as part of both the Microsoft and Netscape browsers and 
most Web server products. Developed by Netscape, SSL also gained the support of Microsoft and other Internet 
client/server developers as well and became the de facto standard until evolving into Transport Layer Security. The 
“sockets” part of the term refers to the sockets method of passing data back and forth between a client and a server 
program in a network or between program layers in the same computer. SSL uses the public-and-private key 
encryption system from RSA, which also includes the use of a digital certificate. 

Shared Key. Shared Key authentication is an algorithm where both the AP and the MU share an authentication key.

Soft Reset. See Warm Boot.

Specular Reflection. The mirror-like direct reflection of light from a surface, which can cause difficulty decoding a bar 
code.

Subnet. A subset of nodes on a network that are serviced by the same router. See Router.

Subnet Mask. A 32-bit number used to separate the network and host sections of an IP address. A custom subnet mask 
subdivides an IP network into smaller subsections. The mask is a binary pattern that is matched up with the IP 
address to turn part of the host ID address field into a field for subnets. Default is often 255.255.255.0.

Substrate. A foundation material on which a substance or image is placed.

Symbol. A scannable unit that encodes data within the conventions of a certain symbology, usually including start/stop 
characters, quiet zones, data characters and check characters.

Symbology. The structural rules and conventions for representing data within a particular bar code type (e.g. UPC/EAN, 
Code 39, PDF417, etc.).

T

TCP/IP. (Transmission Control Protocol/Internet Protocol) A communications protocol used to internetwork dissimilar 
systems. This standard is the protocol of the Internet and has become the global standard for communications. TCP 
provides transport functions, which ensures that the total amount of bytes sent is received correctly at the other end. 
UDP is an alternate transport that does not guarantee delivery. It is widely used for real-time voice and video 
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transmissions where erroneous packets are not retransmitted. IP provides the routing mechanism. TCP/IP is a 
routable protocol, which means that all messages contain not only the address of the destination station, but the 
address of a destination network. This allows TCP/IP messages to be sent to multiple networks within an 
organization or around the world, hence its use in the worldwide Internet. Every client and server in a TCP/IP 
network requires an IP address, which is either permanently assigned or dynamically assigned at startup.

Telnet. A terminal emulation protocol commonly used on the Internet and TCP/IP-based networks. It allows a user at a 
terminal or computer to log onto a remote device and run a program.

Terminal Emulation. A “terminal emulation” emulates a character-based mainframe session on a remote 
non-mainframe terminal, including all display features, commands and function keys. The WT41N0 Series supports 
Terminal Emulations in 3270, 5250 and VT220.

TFTP. (Trivial File Transfer Protocol) A version of the TCP/IP FTP (File Transfer Protocol) protocol that has no directory 
or password capability. It is the protocol used for upgrading firmware, downloading software and remote booting of 
diskless devices.

TKIP. (Temporal Key Integrity Protocol) A wireless encryption protocol that periodically changes the encryption key, 
making it harder to decode. 

Tolerance. Allowable deviation from the nominal bar or space width.

Transmission Control Protocol/Internet Protocol. See TCP/IP.

TLS. (Transport Layer Security) TLS is a protocol that ensures privacy between communicating applications and their 
users on the Internet. When a server and client communicate, TLS ensures that no third party may eavesdrop or 
tamper with any message. TLS is the successor to the Secure Sockets Layer (SSL). 

Trivial File Transfer Protocol. See TFTP.

TSR. See Terminate and Stay Resident.

U

UDP. (User Datagram Protocol) A protocol within the IP protocol suite that is used in place of TCP when a reliable 
delivery is not required. For example, UDP is used for real-time audio and video traffic where lost packets are simply 
ignored, because there is no time to retransmit. If UDP is used and a reliable delivery is required, packet sequence 
checking and error notification must be written into the applications.

U

Visible Laser Diode (VLD). A solid state device which produces visible laser light.

W

Warm Boot. A warm boot restarts the wearable terminal by closing all running programs. All data that is not saved to 
flash memory is lost.
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WAP. (Wireless Application Protocol) A set of specifications, developed by the WAP Forum, that lets developers using 
Wireless Markup Language build networked applications designed for handheld wireless devices. WAP was 
designed to work within the constraints of these devices: a limited memory and CPU size, small, monochrome 
screens, low bandwidth and erratic connections. 

Wearable Terminal. In this text, wearable terminal refers to the WT41N0 wireless portable computer. It can be set up 
to run as a stand-alone device, or it can be set up to communicate with a network, using wireless radio technology.

WEP. Wired-Equivalent Privacy protocol was specified in the IEEE 802.11 standard to provide a WLAN with a minimal 
level of security and privacy comparable to a typical wired LAN, using data encryption. 

WPA. Wi-Fi Protected Access is a data encryption specification for 802.11 wireless networks that replaces the weaker 
WEP. It improves on WEP by using dynamic keys, Extensible Authentication Protocol to secure network access, 
and an encryption method called Temporal Key Integrity Protocol (TKIP) to secure data transmissions. 

WPA2. Wi-Fi Protected Access 2 is an enhanced version of WPA. It uses Advanced Encryption Standard instead of 
TKIP.

WLAN. Wireless local-area networks use radio waves instead of a cable to connect a user device, such as a wearable 
terminal, to a LAN. They provide Ethernet connections over the air and operate under the 802.11 family of 
specifications developed by the IEEE.
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